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1. rész

Bevezetés az ADINA használatába

1.1. Áttekintés

ADINA ≡ Automatic Dynamic Incremental Nonlinear Analysis.

A program tehát egy komplex végeselemes szoftverrendszer, mely a valóságban felme-
rülő legtöbb fizikai probléma modellezésére alkalmas.

1.1. ábra. Munka az ADINA végeselemes rendszerrel

A végeselemes modellezésnél szokásos formában történik a feladatok elemzése, ahogy
ezt az 1.1. ábra szemlélteti. A következőkben a szoftver kezelését tekintjük át.

A program ind́ıtása

Az ADINA alapvetően két változatban ismeretes: UNIX és Windows verziók érhetőek
el, melyek kezeléséhez egy többé-kevésbé egységes grafikus felhasználói felület létezik. Ez
az AUI ADINA User Interface, melynek ind́ıtása:

UNIX alatt (parancssorból):

-> $ aui8.5

Windows alatt:

-> Start Menu → Programs → ADINA System 8.5 → ADINA-AUI
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4 1. RÉSZ: Bevezetés az ADINA használatába

Az AUI egy komplett pre- és post-processzor alkalmazás minden ADINA-beli probléma
vizsgálatához (lásd az 1.2. ábrát).

N E M E G Y C A D R E N D S Z E R !!!

A kezelőfelület

1.2. ábra. ADINA grafikus kezelőfelülete (AUI)

A 1.1. táblázatban összefoglaljuk és röviden léırjuk a grafikus felhasználói felület kü-
lönböző elemeinek a szerepét.

Mértékegységek

Az ADINA rendszerben elvárt input adatok alapvetően számok, melyek sohasem tartal-
maznak mértékegységet. A különböző helyen elvárt adatok konzisztenciájáról a felhasz-
nálónak kell gondoskodni. Például, ha a hosszúság esetében millimétert (mm), az erőnél
pedig Newton (N) egységet használtunk, akkor a nyomás, feszültség egysége MegaPascal
lesz (N/mm2 vagy MPa).

Alapvető modellezési lépések

A program megismerésének legegyszerűbb módja, ha végignézzük a végeselemes anaĺı-
zis során teendő alapvető lépéseket, kezdve a modell létrehozásától egészen az eredmények
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1.1. táblázat. A grafikus felhasználói felület elemei

Elem Léırás
Menu Bar Minden ADINA-ban használható parancs elérhető rajta keresz-

tül, mind a modell előálĺıtásához, mind a kiszámı́tott eredmé-
nyek vizsgálatához.

Toolbars Az ikonok gyűjteménye, melyek a leggyakrabban használt pa-
rancsokat tartalmazzák. Vannak makro ikonok, amelyekhez
tetszőleges AUI parancsot lehet hozzárendelni.

Module Bar Átkapcsolási lehetőség a modell előkésźıtő (preprocessing) és
az utólagos eredmény elemzés (postprocessing) között.

Tree View Egyfajta áttekintést tesz lehetővé a készülő végeselemes mo-
dellre. Nincs minden megjeleńıtve benne, ez nem egy törté-
neti fa. Itt láthatók az Element Groups, Contact Groups,
Materials, Properties, Loads, Boundary Conditions és a
Constraints elemekhez tartozó adatok.

Graphics Window A modellt jeleńıti meg, amelyen éppen dolgozunk. A kinézete
természetesen tetszőlegesen testre szabható.

Message Window A programtól érkező információ és üzenetek megjeleńıtésére
szolgál.

Command Window Általában nem szükséges ezen keresztül parancsokat béırni a
programba, mivel ezek a menüből, illetve ikonokon keresztül
elvégezhetők. De ritka esetekben itt megadható bármilyen
parancs a megfelelő parancs szintaktikával.

Dialog Box Paraméterek adhatók meg, vagy opciók válaszhatók ezen ke-
resztül a modellezés során.

elemzéséig.
A legtöbb lépésnél nincs előre rögźıtett meghatározott sorrend, ezek sok esetben tet-

szőlegesen választhatóak. Azonban van néhány eset, amikor egy-egy lépés végrehajtása
függvénye egy korábban végrehajtandó lépésnek. Például anyagjellemzők, vagy a modell
vezérlő paramétereinek beálĺıtásával lehet kezdeni. De magától értetődően a háló definiá-
lása nem előzheti meg a geometria létrehozását.

A program használata során mindenkiben kialakul egy kényelmes saját sorrend, amely-
ben a modell létrehozása megtörténik. A főbb lépések a következők:

• a modellhez kapcsolt vezérlő paraméterek beálĺıtása (Analysis Control),

• geometria létrehozása (Geometry),

• anyagmodell létrehozása, anyagjellemzők megadásával (Materials),

• fizikai jellemzők tárśıtása a modell geometriájához (Physical Properties),

• kinematikai t́ıpusú peremfeltételek elő́ırása (Boundary Conditions),

• terhelések, erő t́ıpusú peremfeltételek definiálása (Loads),

• végeselemes háló létrehozása (Meshing),

• a szimuláció végrehajtása (Solution),

• eredmények elemzése (Post-Processing).
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1.2. A grafikus felhasználói felület

Ikonok

Három különböző ikont́ıpust találhatunk az AUI-ben:

• hagyományos – ezen ikonok az előre programozott feladatokat hajtják végre,

• makro – ezen ikonoknál a feladatot a felhasználó programozhatja tetszés szerint,

• lenýıló – ez tulajdonképpen egy ikongyűjtő, mely több hasonló feladatot ellátó ikont
tartalmaz.

Az ikonokat a szoftverben csoportokba rendezhetjük, melyek a következő Toolbar-
okban találhatóak meg:

• General Toolbar : pl. Open , Save , Clear , Mesh Plot, , stb.

• Modeling Toolbar : pl. Define Point , Define Lines , stb.

• Display Toolbar : pl. Wireframe , Iso View 1 , YZ View , stb.

• Results Toolbar : pl. Band Plot , Smooth Plots , Show Original Mesh , stb.

• ADINA-M: Testmodellező parancsok (900 csomópontos verzióban nem elérhető).

Dinamikus objektum mozgatás

A General Toolbar -on kiválaszthatóak az egér mozgatásával végezhető dinamikus moz-
gatás (Dynamic Pan) , nagýıtás-kicsinýıtés (Dynamic Resize) és forgatás (Dynamic
Rotate XY), vagy (Dynamic Rotate Z ) ikonjai.

Azonban a Pick/kiválasztás parancs bekapcsolásával aktiválhatóak a következő,
rajzolást, megtekintést seǵıtő funkciók a billentyűzet használatával:

• Ha nem nyomunk meg semmilyen billentyűt, csak a ḱıvánt objektumot kiválasztva,
az egér 1-es gombját nyomva tartva mozgathatjuk a ḱıvánt elemet.

• Nyomva tartva a Ctrl billentyűt, a dinamikus nagýıtás-kicsinýıtés működik az egér
mozgatásra.

• Nyomva tartva a Shift billentyűt, a dinamikus forgatás aktivizálódik (XY tengelyek
körül).

• Nyomva tartva az Alt billentyűt, a dinamikus forgatás a Z tengely körül működik.

Néhány ablakkezelő lefoglalja saját célra ezen utolsó funkciót, ı́gy ez nyilván nem
megfelelően működik minden esetben.

A modul kiválasztás/Module Bar

A Module Bar (1.3. ábra) teszi lehetővé, hogy a szoftver különböző részeit ind́ıtsuk,
illetve a hozzájuk tartozó paramétereket beálĺıtsuk. Az 1.2. táblázatban ezen lehetőségeket
soroljuk fel.
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1.3. ábra. A Module Bar vezérlő elemei

1.2. táblázat. A Module Bar lehetőségei

Vezérlő elem Jellemző művelet
Program Module A modell előálĺıtásához (preprocessing) kiválasztja a megfe-

lelő program modult (ADINA Structures, ADINA CFD, vagy
ADINA Thermal), illetve választható a lenýıló listából a Post-
Processing, a kapott eredmények elemzéséhez. Minden egyes
listaelem választáskor más-más menü jelenik meg, amely az
adott modulhoz aktuálisan elérhető parancsokat tartalmazza.

Analysis Type Az anaĺızis t́ıpusát álĺıtjuk be vele. A választható elemek függ-
nek a beálĺıtott modultól.

Analysis Options A kiválasztott anaĺızis t́ıpushoz különböző változtatható pa-
raméterek tartoznak, melyek beálĺıtását a listaelemtől függő
dialógus ablakokon keresztül lehet elvégezni.

FSI Két modulnál, a Structures és a CFD-nél érhető el. Ezzel ı́rjuk
elő, hogy a folyadék áramlást figyelembe ḱıvánjuk-e venni.

FSI Options Csak a CFD modulnál elérhető. Bizonyos vezérlő paraméterek
beálĺıtása a folyadékáramláskor.

Flow Compressibility A folyadék összenyomhatóságára vonatkozó adatok elő́ırása.

A fa nézet/Tree View

A grafikus ablak bal oldalán található fában bizonyos jellemzőket tudhatunk meg a
vizsgált modelről. Ezen elem csak a pre-processing lépésnél érhető el. A fában található
elemeknél különböző feladatok érhetők el, melyek aktivizálása a megfelelő elemre való 3-as
egérgombbal való kattintással történik.

Ilyen műveletek például egy elemcsoport (Element Group) definiálása, vagy a már
meglévő elemcsoportok módośıtása, törlése és kiemelése.

A Tree View-ban megjelenő elemeket rövid léırásukkal az 1.3. táblázat tartalmazza.

1.3. táblázat. A Tree View elemei
Elem neve Szerepe
Element Group A modellben definiált elemt́ıpusok megjeleńıtése. Az itt elérhető

parancsok: Modify..., Delete..., Set Current, Highlight.
Material A modellben definiált anyagmodellek, melyek innen a fából köz-

vetlenül módośıthatók vagy törölhetők.
Cross Section Rúdkeresztmetszetek felsorolása, melyek a modellhez kapcsolód-

nak. Ezek is módośıthatók, vagy törölhetők a 3-as egérgombbal.
Spring Property A modellhez kapcsolódó rugójellemzők.
Fixity Megfogás t́ıpusú peremfeltételek megjeleńıtése, módośıtása vagy

törlése.
Loading Erő, nyomás, stb. t́ıpusú dinamikai peremfeltételek megjeleńıtése,

módośıtása vagy törlése.
Initial Condition Kezdeti feltételek megadása, módośıtása, vagy törlése.
Constraints Kényszeregyenletek definiálása, módośıtása, vagy törlése.
Contact Group Érintkezési feltételek elő́ırása, módośıtása, törlése, vagy kiemelése.
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A grafikus ablak/Graphics Window

A grafikus ablakban éṕıtjük fel a végeselemes modellt, illetve az eredményeket itt
jeleńıthetjük meg különböző módokon.

Az alapvető műveletek a következők:

• A háttérsźın változtatható tetszőlegesen a menüből (Edit → Background Color).

• Minden objektum törlése (ideiglenes eltakaŕıtása) a rajzterületről a Clear ikonnal
lehetséges.

• A grafikus ablakon tetszőleges számú példány lehet a modellből. A Mesh Plot
ikon egy új hálót jeleńıt meg a modellhez.

• A modellhez definiált kinematikai peremfeltételek megjeleńıtését a Boundary Plot

parancs jeleńıti meg.

• A Load Plot parancs az erő t́ıpusú, vagy feszültségi peremfeltételek megjeleńıté-
sére szolgál.

Ezen utóbbi két parancs, mint kapcsolók funkcionálnak. Azaz a Boundary Plot és
a Load Plot ikonok bármikor ki- és bekapcsolhatók igénytől függően.

• A Pick/kiválasztás ikon a grafikus ablakban található objektumok kiválasztására
szolgál. Számos elem kijelölhető ablak t́ıpusú kiválasztással is.

• A kiválasztott objektumok törölhetők az Erase ikon által.

• A Query parancs információ gyűjtésre szolgál a ḱıvánt geometriai, vagy végesele-
mes objektumról.

• A Zoom és az Unzoom parancsok egy adott terület nagýıtását/kicsinýıtését
teszik lehetővé.

A grafikus ablak tartalmának mentése

Az ADINA lehetőséget ad, hogy vektorgrafikus, vagy bitmap formában elmentsük az
aktuális grafikus ablak tartalmát. A következő file-formátumok késźıtését támogatja a
szoftver:

• Vektorgrafikus ábrák : PostScript (.ps), vagy Adobe Illustrator (.ai). Elérése
a Vector Snapshot paranccsal.

• Bitmap képek : JPEG (.jpg), vagy bitmap (.bmp). Elérése a Bitmap Snapshot
paranccsal.

Alapértelmezés szerint a vektorgrafikus ábrák háttérsźıne mindig fehér, mı́g a bitmap
képeknél a háttérsźın mindig az ADINA-ban beálĺıtott háttérsźın lesz.
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1.3. A modell vezérlő adatai/Analysis Control

A végeselem modell általános viselkedését álĺıtjuk be a vezérlő/Analysis Control pa-
ramétereken keresztül, melyek például a következők: szöveges fejléc, időlépések száma,
elmozdulások, illetve alakváltozások mértéke (kis/nagy), az egyenletrendszer-megoldó t́ı-
pusa, konvergencia toleranciák, stb.

Általánosan elmondható, hogy ezen adatok a modell késźıtése során bármikor megad-
hatóak, illetve módośıthatóak (természetesen a szimuláció végrehajtása előtt). Továbbá
az is megjegyezendő, hogy az alapértelmezett paraméterbeálĺıtás sok egyszerű modell ese-
tében megfelelő, tehát nem szükséges ezeken álĺıtani.

A vezérlő adatok a következő egyszerű csoportokra bonthatók:

• Anaĺızis t́ıpusa.

• Szabadságfok elő́ırása.

• Időfüggvények, melyek a számı́tásoknál a terhelés elő́ırását vezérlik.

• Időlépés, mely alapvetően a nemlineáris számı́tás kulcsadata.

• Feltételezések: kis/nagy elmozdulások, alakváltozások, hőmérsékleti jellemzők.

• Megoldási technika, pl. egyenletrendszer megoldó, toleranciák, újraind́ıtási adatok,
egyensúlyi iterációk.

• A kimeneti adatok mennyisége, jellege.

• Az eredmény tárolási módja (.port file).

Most csak néhány fontosabb vezérlő paramétert tekintünk át.

Az anaĺızis t́ıpusa

1.4. ábra. Anaĺızis t́ıpusa

A Module Bar seǵıtségével álĺıthatjuk be a legegyszerűbben a ḱıvánt anaĺızis t́ıpust,
ahogy ez az 1.4. ábrán látható.

A lenýıló listából választva különböző feladatt́ıpusok megoldása válik elérhetővé, me-
lyekhez további paraméterek beálĺıtása lehetséges a gomb megnyomása után, melyek
rövid áttekintését adja az 1.4. táblázat.

Megadható parancssorból is, melynek szintaxisa:

-> MASTER ANALYSIS=<type>
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1.4. táblázat. Anaĺızis t́ıpusok és beálĺıtható paraméterek

Anaĺızis t́ıpusok Beálĺıtható paraméterek
Statics Statikai feladatok. Definiálható több terhelési lépcső, vagy

automatikus időlépés álĺıtás (ATS).
Dynamics-Implicit Implicit dinamika. Időintegrálás és automatikus időlépés

álĺıtás (ATS).
Dynamics-Explicit Explicit dinamika. Időintegrálás és automatikus időlépés

álĺıtás (ATS).
Frequencies/Modes Sajátfrekvencia számı́tás beálĺıtásai, pl. darabszám, megha-

tározási módszer, kimeneti feszültség adatok.
Mode Superposition Beálĺıtható, hogy mely sajátfrekvenciák, mely sajátvektorok

kerüljenek beolvasásra és kiszámı́tásra, illetve milyen mód-
szerrel.

Modal Stress Beálĺıtható, hogy mely sajátfrekvenciák, mely sajátvektorok
kerüljenek beolvasásra és kiszámı́tásra, illetve milyen mód-
szerrel.

Modal Participation F. Beálĺıtható, hogy mely sajátfrekvenciák, mely sajátvektorok
kerüljenek beolvasásra és kiszámı́tásra, illetve milyen mód-
szerrel.

Linearized Buckling Kihajlás anaĺızis. Megoldási módszer paraméterei álĺıtha-
tók.

Collapse Analysis Megadható a pont, vagy csomópont, ahol az elmozdulás ve-
zérelve van, illetve megoldási paraméterek álĺıthatók.

Szabadságfokok

A teljes modell vonatkozásában elő́ırjuk vele a feladathoz rendelt ismeretlenek számát.
A szabadságfok megadása a 1.5. ábrán jelzett dialógusablakon keresztül történik az ADINA-
AUI felületen, melyet a menüben a Control → Degrees of Freedom... elemmel érünk
el.

1.5. ábra. Szabadságfokok elő́ırása

A beálĺıtható adatok:

(A) Az 1.5. ábrán legfontosabb a Master Degrees of Freedom [IDOF] beálĺıtása. Az
alapértelmezés szerint minden szabadságfok akt́ıv, azaz mindhárom irányban lehet-
séges elmozdulás és forgás. Ha a modell úgy ḱıvánja, hogy valamely irányban a
mozgás, fordulás nem lehetséges, akkor azon jellemző elől törölni kell a jelölőnégy-
zetet, pl.

• egy śıkfeszültségi, vagy śıkalakváltozási feladat esetén az X-Translation, Y-
Translation és Z-Rotation szabadságfokok rögźıtettek, mivel az ilyen modellt
Y − Z śıkban kell késźıteni.

(B) Pipe elemt́ıpus esetén szükséges lehet figyelemmel lenni az Ovalization/Warping
DOF at... paraméter beálĺıtására. Itt lehetséges In-plane/śıkbeli, Out-plane śıkra
merőleges, vagy All t́ıpusú deformációt elő́ırni, mely a terhelés függvénye.
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(C) Héjmodell esetén a középfelületen szükséges szabadságfok számot ı́rhatjuk itt elő
(részletesebb léırásért lásd ADINA kézikönyvet).

A szabadságfok megadható parancssorból is, melynek szintaxisa:

-> MASTER IDOF=<...> OVALIZATION=<...> SHELLNDOF=<...>

Időfüggvény

Az ADINA-AUI felületen az 1.6. ábrán látható dialógus ablak seǵıtségével adhatjuk meg
a modellben használni ḱıvánt időfüggvény defińıcióját. A menüben a Control → Time
Function... menüelemmel érhetjük el.

Ennek a vezérlő paraméternek a célja, hogy elő́ırja a szoftver számára azt, hogy a
terhelést milyen módon ḱıvánjuk a vizsgált modellen működtetni. Természetesen az itt
létrehozott időfüggvényt később a modell definiálásakor, a terhelések elő́ırása során hasz-
náljuk fel egyszerű sorszám hivatkozással.

Egy nemlineáris statikai feladat megoldása sok esetben nem lehetséges, ha az al-
kalmazni ḱıvánt terhelést egyetlen időlépés alatt a szerkezetre tesszük, ezért az idő-
függvény seǵıtségével egyenletesen növekvő módon helyezzük azt a modellre, több
időlépésben.

1.6. ábra. Időfüggvény definiálása

Van egy alapértelmezett időfüggvény 1-es azonośıtóval, mely egy konstans 1.0 értékű
függvény. Ez látható az 1.6. ábrán is.

Az időfüggvény megadható parancssorból is, melynek szintaxisa:

-> TIMEFUNCTION

Időlépések

Az ADINA-AUI felületen az 1.7. ábrán látható dialógus ablak seǵıtségével adhatjuk meg
a modellben használni ḱıvánt időlépések defińıcióját. A menüben a Control → Time
Step... menüelemmel érhetjük el.
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Ez a vezérlő paraméter definiálja az idő/terhelés lépés növekményeit az anaĺızis során.
Minden sor az 1.7. ábrán látható táblázatban tartalmazza az adott mértékű lépéshez tar-
tozó lépések számát. Alapértelmezett időlépésként 1 lépés definiálva van 1.0 hosszúsággal.

Statikai számı́tásnál, ahol nincsen időtől függő hatás figyelembe véve az anyagmodell-
nél (pl. kúszás, vagy viszkozitás), ott az idő csak egy ”dummy” változó, mely közvetlenül
kapcsolódik az időfüggvényhez. Azaz az időlépések időbeli hossza nem lényeges egy lineáris
statikai feladat megoldásakor.

Dinamikai, vagy olyan statikai feladatoknál, amikor az anyagmodell szempontjából
időfüggés szerepel, akkor az idő már ”valós” változóként jelenik meg, mivel a mozgásegyen-
letet, illetve az anyagi időfüggést már a konkrétan eltelt idő függvényében kell tekinteni.
Ezért az időlépés hosszának megválasztásától már nem független a megoldás!

1.7. ábra. Időlépések definiálása

Az időlépések megadhatók parancssorból is, melynek szintaxisa:

-> TIMESTEP

Modellbeli feltevések

Az ADINA-AUI az 1.8. ábrán felsorolt felételezések beálĺıtását engedélyezi. Itt most
csak a kinematikára vonatkozó lényeges elemeket tekintjük át.

1.8. ábra. ADINA feltevések

Az ADINA-AUI felületen az 1.9. ábrán látható dialógus ablak seǵıtségével adhatjuk meg
a modellben használni ḱıvánt kinematikai feltevések paramétereit, melyet a Control →
Analysis Assumptions → Kinematics... menüelemmel érhetünk el.

A beálĺıtható paramétereknél tekintettel kell arra lenni, hogy nem minden modellnél
használhatók bizonyos adatok. Például
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A Nagy alakváltozás (large strains) csak héj, 2-D és 3-D Solid elemt́ıpus esetén
működhet, bizonyos anyagmodellek esetében. (Részletesebben lásd az ADINA kézi-
könyvet.)

B Az alapértelmezés az ún. Updated Lagrangian Jaumann (ULJ) formalizmus. Egyéb-
ként választható az ún. Updated Lagrangian Hencky (ULH) formalizmus is.

C Az Automatic beálĺıtás az Igen-t jelenti, kivéve, ha Explicit Dynamic a modell
t́ıpusa.

D A merev kapcsolódás modellezéséhez szükséges paraméter.

E Nyomástól függő korrekciós tag beéṕıtését engedélyezi ez a kapcsoló, melynek nagy
alakváltozásos nyomással terhelt héjszerkezetek vizsgálatakor lehet jelentős szerepe.

1.9. ábra. Kinematikára vonatkozó feltevések beálĺıtása

A kinematikai paraméterek megadhatók parancssorból is, melynek szintaxisa:

-> KINEMATICS

A megoldási folyamat vezérlése

Az ADINA-AUI felületről a Control → Solution Process... menüpont seǵıtségével
jutunk az 1.10. ábrán jelzett dialógusablakhoz, melynek seǵıtségével számos szimulációs
vezérlő adatot beálĺıthatunk.

1.10. ábra. A megoldási folyamat vezérlése
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(A) A lineáris egyenletrendszer megoldó t́ıpusát adhatjuk itt meg. Az alapértelmezett
megoldó a sparse/ritka-mátrix megoldó, mely az esetek túlnyomó részében rend-
ḱıvül hatékony eszköz. Azonban a 3D-iterative megoldó is hasonlóan gazdaságos
egyenletrendszer megoldó (kevesebb memóriát igényel és gyors a végrehajtási ideje),
ha a feladatban nagyszámú magas szabadsági fokú 3D-s végeselem szerepel. Az ite-
rat́ıv megoldó jól funkcionál nemlineáris feladatok esetében is (ideértve az érintkezési
feladatokat is).

A non-symmetric sparse megoldó hatékonyan dolgozik például a Mohr-Columb és
a Drucker-Prager anyagmodellek esetében is.

(B) Az újraind́ıtott szimulációknál használatos, mely érték a legutóbbi számı́táskor el-
mentett időt jelenti.

(C) Egy korábbi futás elmentett adatai alapján számol tovább a szoftver, melyhez létezni
kell a megfelelő .res állománynak az előző futásból. Ekkor a geometria és a legtöbb
elemhez kötött adat nem módośıtható, azonban álĺıthatók a következő dolgok:

• időlépés, végrehajtási lépésszám,

• időfüggvény, mely vezérli a terhelés eseteket,

• statikus modell átálĺıtása dinamikussá (vagy vissza),

• konvergencia kritériumok, automatikus időléptetés (ATS), vagy terhelés-elmozdulás
vezérlés beálĺıtása (LDC),

• terhelések, megfogások,

• anyagjellemzők,

• kényszeregyenletek,

• csillaṕıtási tényezők.

(D) Alapértelmezés szerint a szinguláris merevségi mátrix észlelése megálĺıtja a futást.
Ennek a paraméternek a beálĺıtása természetesen körültekintést ḱıván, mivel ez a
jelenség nagy valósźınűséggel valamilyen modellbeli fogyatékosságra utal.

A megoldási folyamatot vezérlő paraméterek megadhatók parancssorból is, melynek
szintaxisa:

-> MASTER

Eredmények kiiratása

Egy ADINA szimuláció során az output állomány mindig előálĺıtásra kerül egy .out file-
ba. A vezérlő adatok seǵıtségével elő lehet ı́rni, hogy mely információra van szükségünk a
későbbi vizsgálatokhoz:

• megadható, hogy az input adatokból, elemekről, csomópontokról mit tároljunk,

• megadható a csomópontok köre, amelyekben az eredményt kinyomtatjuk,

• megadható azon elemek köre is, amelyekben az eredményt kinyomtatjuk,

• definiálhatók azok az időlépések is, melyekben ḱıváncsiak vagyunk az eredményekre.
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Alapértelmezés szerint nem kerülnek kíıratásra a csomópontokhoz, illetve elemekhez
kötött input adatok. Ennek elő́ırása a Control→ Printout→ Volume... menüparancsra
nýıló dialógusablakon álĺıtható be.

A kíıratási folyamatot vezérlő paraméterek megadhatók parancssorból is, melyhez a
következő parancsok tartoznak:

-> PRINTOUT

-> PRINTNODES

-> PRINT-STEPS

Ezekről bővebben lásd az ADINA kézikönyvet.

A Porthole állomány

Ez a file tartalmazza a szimuláció eredményét (.port kiterjesztéssel), mely felhasznál-
ható a post-processing során. Alapértelmezésben ez az állomány bináris, de külön kérésre
lehetőség van ascii (text) formátumú porthole file-t ellőálĺıtani. Azonban erről tudni kell,
hogy ez legalább 2-2, 5× nagyobb, mint a bináris változat.

Másik megjegyzés az, hogy a szöveges t́ıpusú eredményfile bármely platformon egyaránt
megnyitható, mı́g a bináris állomány csak bizonyos kompatibilis rendszerekben használható
egyforma módon.

Az eredményfile-ba ı́rt információ t́ıpusa és mennyisége álĺıtható az AUI felületen a
menüből Control → Porthole elemei seǵıtségével.

A porthole állomány tartalmát vezérlő paraméterek megadhatók parancssorból is,
melyhez a következő parancsok tartoznak:

-> PORTHOLE

-> SAVENODES

-> NODESAVE-STEPS

-> ELEMSAVE-STEPS

Ezekről bővebben lásd az ADINA kézikönyvet.

1.4. Geometria létrehozása

Az ADINA-AUI kétféle t́ıpusú geometriát különböztet meg.

1. Simple geometry/egyszerű geometria, mely tartalmazza a pontok, vonalak, felüle-
tek és térfogatok defińıcióját és ezek egymásra épülnek. Azaz egy felületet három,
vagy négy vonal álĺıt elő, mı́g egy térfogatot négy, öt vagy hat felület határolhat.

2. ADINA-M geometry, mely a testmodellezés elemeinek megfelelő primit́ıvekből épülhet
fel. Így megtaláljuk benne az él, lap és test fogalmakat. A testeket lapok, mı́g a
lapokat élek határolják. Fontos azonban, hogy az élek és a lapok nem különálló
objektumok, hanem a testek részeként vannak értelmezve.

A pontok mindkét geometria t́ıpusnál megtalálhatók.
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Az ADINA-M (ADINA Modeler) egy beépülő modulja az AUI-nak. Ha ehhez nincs
érvényes license, akkor ez a menüpont nem érhető el a szoftverben.

FONTOS, hogy már a geometria definiálásakor tekintettel legyünk a végeselemes
modell jellegére. A 2D-s (tengelyszimmetrikus, śıkalakváltozási, vagy śıkfeszültségi)
feladatokhoz tartozó geometriának muszáj a globális Y Z śıkba kerülnie.
Továbbá, ha tengelyszimmetrikus a feladat, akkor az összes elemnek a +Y részébe
kell kerülni a teljes modellnek. Mivel a Z a forgástengely.

Geometriai objektumok számozása. Az AUI egyszerű számozási konvenciót használ
a különböző geometriai elemek azonośıtására:

• A test, térfogat, felület, vonal és a pont azonośıtó sorszáma mindig egyedi. Tehát nem
lehetséges két egyforma sorszámú, azonos családba tartozó objektumot létrehozni.

• A lapok és élek sorszámai mindig lokális jellegűek, melyek tartalmaznak még egy
referencia hivatkozást is a megfelelő testre. Tehát lehet 1-es lapja az 1-es testnek és
a 2-es testnek is. De amikor például hálózásra kerül sor és ezen elemeket azonośıtani
kell, akkor mindig elő kell ı́rni azt is, hogy mely test lapjáról van éppen szó.

Koordinátarendszerek

A koordinátarendszerek létrehozása a Geometry → Coordinate Systems... menü-
elem, vagy a Coordinate Systems parancs seǵıtségével érhető el.

Az alapértelmezés szerint minden geometriai elem a globális Kartéziuszi-rendszerben
kerül definiálásra (ez a Coordinate System 0). Ez a legtöbb modell esetében teljesen
kieléǵıtő, és nem szükséges további saját koordinátarendszer létrehozása.

1.11. ábra. Koordinátarendszer definiálása

Csak akkor érdemes saját rendszert létrehozni, ha abban a geometria léırása egyszerűbb
és gyorsabb. Három alapvető koordinátarendszert ismer a szoftver:

• Kartéziuszi koordinátarendszer

• hengerkoordináta koordinátarendszer
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• gömbi koordinátarendszer.

Mind a három rendszer jobbsodrású és a globális rendszerhez képest adható meg. Erről
bővebben lásd az ADINA kézikönyvet.

A koordinátarendszerek megadhatók parancssorból is, melyhez a következő parancs
tartozik:

-> SYSTEM

Pontok

A pontok létrehozása az első lépés az egyszerű geometriai alakzatok definiálása során.
Az ADINA-M-ben a pontokat automatikusan hozza létre a rendszer, a geometriai primit́ıvek
definiálásakor.

A pontokat előálĺıthatjuk a globális vagy az általunk definiált lokális koordinátarend-
szerben egyaránt.

Pont létrehozásához válasszuk a Geometry→ Points... menüparancsot, vagy a Tool-

bar-ból a ikont. A megnýıló táblázatban meg kell adni, minden sorban egyesével a
definiálandó pontok azonośıtó számát és a pont koordinátáit.

Pont törlése. Erre két lehetőség van:

• vagy a Define Points paranccsal elérhető táblázatból kitöröljük a ḱıvánt
sort;

• vagy ezzel egyenértékű eredményre jutunk, ha a Delete Points parancs
kéri, hogy válasszuk ki a törlendő pontot a rajzterületen.

Természetesen azok a pontok, melyek még más geometriai elem defińıciójában sze-
repelnek nem törölhetők.

1.12. ábra. Pontok definiálása

A pontok létrehozása megadható parancssorból is, melyhez a következő parancs
tartozik:

-> COORDINATES POINT
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Vonalak

Vonalak csak akkor hozhatók létre, ha már a modell tartalmaz pontokat, melyekre
lehet hivatkozni. Ehhez válasszuk a Geometry → Lines → Define... menüelemet, vagy
a Toolbar-on a ikont.

Vonal definiálása. A felnýıló dialógusablakban az Add gombra kattintás után elő
kell ı́rni a vonal t́ıpusát, majd megadni a szükséges inputot és végül a Save gombot kell
választani.

Lehetőség van a pontok egybeesését figyeltetni a szoftverrel, melyhez a Check Coin-
cidence jelölőnégyzetet be kell kapcsolni.

Vonal törlése. Hasonlóan a pont törléséhez itt is két lehetőség van.
Vagy a Define Lines parancsra megjelenő dialógus ablakon jelölük ki törlendő
vonal sorszámát, és válasszuk utána a Delete gombot.
Vagy a Delete Lines parancsot ind́ıtjuk el és a grafikus ablakon válasszuk ki a
törlendő vonalakat. A parancs lezárása az ESC billentyűvel.
A vonalakat definiáló pontok nem kerülnek automatikusan törlésre.

1.5. táblázat. Létrehozható vonalfajták

Vonal t́ıpus Léırás
Straight Két pont között húzható egyenes.
Arc Köŕıv, vagy változó sugarú ı́v létrehozása.
Circle Kör rajzolása.
Curvilinear Interpolációs görbe, szakaszonként egyenesekkel létrehozva egy választott

lokális koordinátarendszerben.
Polyline Pontsorozat által definiált poligon, ahol az egyes szakaszok lehetnek egye-

nesek vagy spline-ok.
Combined Korábban definiált vonalak kombinációjával álĺıtjuk ezt a vonalt́ıpust elő.
Section Egy másik vonal egy részéből hozzuk létre ezt a vonalt́ıpust.
Revolved Egy köŕıv késźıthető vele, egy pont tengely körüli forgatásával.
Extruded Egy egyenes vonal hozható létre vele, egy pont adott irányba való eltolá-

sával (extrude).
Transformed Más vonalak geometriai transzformációjával álĺıtható elő.

1.13. ábra. Vonalak definiálása
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A vonalak létrehozása megadható parancssorból is, melyhez a következő parancs
tartozik:

-> LINE <type>

Felületek

A felület-definiáló dialógus ablak (1.14. ábra) a menüből elind́ıtható a Geometry →
Surfaces → Define... paranccsal vagy a ikonnal.

Egy geometriai felület csak három vagy négy vonal által lehet határolva, mely a végén
ı́gy lehet śıkbeli vagy nem śıkbeli. A felülethez mindig tartozik egy lokális (u, v) koor-
dinátarendszer, melynek egységvektorai is megjeleńıthetők a Surface/Face Labels
paranccsal.

1.14. ábra. Felületek létrehozása

1.6. táblázat. Létrehozható felületfajták

Felület t́ıpus Léırás
Patch Három, vagy négy vonal seǵıtségével hozunk létre egy felületet.
Vertex Három, vagy négy pont seǵıtségével hozunk létre egy felületet.
Grid Egy pontháló seǵıtségével definiáljuk a geometriát.
Revolved Egy felület késźıthető vele, egy vonal tengely körüli forgatásával.
Extruded Egy felület hozható létre vele, egy vonal adott irányba való eltolásával

(extrude).
Transformed Más felületek geometriai transzformációjával álĺıtható elő.

Felület törlése. Hasonlóan a pont, vagy vonal törléshez itt is két lehetőség van:

• vagy a Define Surfaces parancsra megjelenő dialógus ablakon jelöljük ki
a törlendő felület sorszámát, és válasszuk utána a Delete gombot;

• vagy a Delete Surfaces parancsot ind́ıtjuk el és a grafikus ablakon vá-
lasszuk ki a törlendő felületeket.

A parancs lezárása az ESC billentyűvel történik.
A felületeket definiáló vonalak, pontok nem kerülnek automatikusan törlésre.
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A felületek létrehozása megadható parancssorból is, melyhez a következő parancs
tartozik:

-> SURFACE <type>

Térfogatok

A térfogat-definiáló dialógus ablak (1.15. ábra) a menüből elind́ıtható a Geometry →
Volumes → Define... paranccsal, vagy a ikonnal.

Egy geometriai térfogat hat, öt, vagy négy geometriai felülettel lehet határolva, mely
a végén ı́gy topológiailag egyenrangú egy kockával, prizmával, gúlával, vagy egy tetra-
éderrel. A térfogathoz mindig tartozik egy lokális (u, v, w) koordinátarendszer, melynek
egységvektorai is megjeleńıthetők a Surface/Face Labels paranccsal.

1.15. ábra. Térfogati tartomány definiálása

1.7. táblázat. Létrehozható térfogat-fajták

Térfogat t́ıpus Léırás
Patch Hat, öt, vagy négy felület seǵıtségével hozunk létre egy térfogatot.
Vertex Nyolc, hat, öt, vagy négy sarokpont seǵıtségével hozunk létre egy tér-

fogatot.
Revolved Egy térfogat késźıthető vele, egy felület tengely körüli forgatásával.
Extruded Egy térfogat hozható létre vele, egy felület adott irányba való eltolá-

sával (extrude).
Transformed Más térfogatok geometriai transzformációjával álĺıtható elő.

A térfogatok létrehozása megadható parancssorból is, melyhez a következő parancs
tartozik:

-> VOLUME <type>
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Térfogat törlése. Hasonlóan a pont, vonal, vagy felület törléshez itt is két lehetőség
van:

• vagy a Define Volumes parancsra megjelenő dialógus ablakon jelöljük ki a
törlendő térfogat sorszámát, és válasszuk utána a Delete gombot;

• vagy a Delete Volumes parancsot ind́ıtjuk el és a grafikus ablakon vá-
lasszuk ki a törlendő térfogatot.

A parancs lezárása az ESC billentyűvel történik.
A térfogatokat definiáló felületek, vonalak, pontok nem kerülnek automatikusan tör-
lésre.

1.5. Anyagmodellek

A szoftverben a használni ḱıvánt anyagmodellt el kell látni a ḱıvánt paraméterekkel.
A definiáláshoz a Model→ Materials→ Managage Materials... menüelemmel, vagy a

ikonparaccsal, illetve közvetlenül is választhatjuk a ḱıvánt anyagmodellt a Materials
almenüből.

A létrehozott anyagjellemző tábla a szoftver számára a modellezés későbbi lépéseihez
egy azonośıtó számmal van ellátva, melyre a végeselemek létrehozásakor kell hivatkozni.
Így, ha több anyagmodellt alkalmazunk egy szimuláció során, akkor ezen anyagtáblák
azonośıtó sorszámait tudni kell.

A számtalan anyag- és elemt́ıpus kapcsolata érdekében javasolt a megfelelő ADINA on-
line kézikönyv tanulmányozása, mivel nem választható tetszőleges anyagmodell minden
elemt́ıpushoz.

1.16. ábra. Anyagok paramétereinek definiálása
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Az anyagok definiálása megadható parancssorból is, melyhez a következő parancs
tartozik:

-> MATERIALS <type>

1.6. Fizikai paraméterek

Bizonyos elemt́ıpusok alkalmazása a pusztán geometriai adatok mellett megḱıvánja
bizonyos fizikai jellemzők elő́ırását is. Ilyenek például a vastagság, vagy a keresztmetszet
(lásd 1.17. ábra) jellege (geometriája).

1.17. ábra. Keresztmetszet jellemzőinek definiálása

A keresztmetszet beálĺıtása megḱıvánja annak előzetes definiálását. Ehhez a Model →
Element Properties → Cross-Sections... menüparanccsal vagy a ikonnal elérhető
dialógusablakon szükséges adatokat elő́ırni. Az 1.18. ábra jelzi az elérhető keresztmetszet
t́ıpusokat.

Fontos. A keresztmetszet definiálása csak a lokális s− t koordinátarendszert hatá-
rozza meg. A rúd hossza menti r tengely irányát egy kiegésźıtő ponttal lehet elő́ırni.
Az r− s śıkot a rúdelem két végcsomópontja (1 és 2 csomópont), illetve a kiegésźıtő
(auxiliary node) csomópont adja.

Az 1.8. táblázat a különböző elemt́ıpusokat sorolja fel melyek használnak bizonyos
fizikai jellemzőket.

A keresztmetszetek létrehozása megadható parancssorból is, melyhez a következő
parancs tartozik:

-> CROSS-SECTION <type>



1.6. FIZIKAI PARAMÉTEREK 23

1.18. ábra. Keresztmetszet t́ıpusok
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1.8. táblázat. Fizikai jellemzők összefoglalása

Elem t́ıpus Jellemző Hozzárendelési mód
Truss keresztmetszet területe

(def.: 1.0)
Model → Element Properties →Truss...

–> LINE-ELEMDATA TRUSS

–> EDGE-ELEMDATA TRUSS

Beam keresztmetszet azono-
śıtó (def.: 1)

Model → Element Properties → Beam...

–> LINE-ELEMDATA BEAM

–> EDGE-ELEMDATA BEAM

Isobeam keresztmetszet azono-
śıtó (def.: 1)

Model → Element Properties → Iso-
beam...
–> LINE-ELEMDATA ISOBEAM

–> EDGE-ELEMDATA ISOBEAM

Pipe keresztmetszet azono-
śıtó (def.: 1)

Model → Element Properties → Pipe...

–> LINE-ELEMDATA PIPE

–> EDGE-ELEMDATA PIPE

Isobeam
(axisym.shell)

vastagság (def.: 1.0) Geometry → Lines → Thickness...

–> LNTHICKNESS

2-D Solid
(plane stress)

vastagság (def.: 1.0) Geometry → Surfaces → Thickness...

Geometry → Faces → Thickness...
–> SFTHICKNESS

–> FACE-THICKNESS

Plate vastagság (def.: 1.0) Geometry → Surfaces → Thickness...
Geometry → Faces → Thickness...
–> SFTHICKNESS

–> FACE-THICKNESS

Shell vastagság (def.: 1.0) Geometry → Surfaces → Thickness...
Geometry → Faces → Thickness...
–> SFTHICKNESS

–> FACE-THICKNESS
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1.7. Kinematikai peremfeltételek

A megfogási peremfeltételek elő́ırása a Model → Boundary Conditions → Apply Fi-

xity... menüelemmel, vagy a Toolbar-on lévő ikonnal elérhető dialógusablakban
(1.19. ábra) lehetséges.

1.19. ábra. Megfogási peremfeltétel elő́ırása

Kinematikai peremfeltételt elő́ırhatunk geometriai objektumra, vagy csomópontok tet-
szőleges halmazára, mellyel néhány, vagy akár az összes szabadságfokát rögźıthetjük a
modell bizonyos részeinek.

A peremfeltételi elő́ırás beálĺıtása:

(A) Kiválasztjuk, hogy mely geometriai elemre, vagy csomóponti halmazra ḱıvánunk
elő́ırással élni.

(B) Ha szükséges, definiáljunk peremfeltétel t́ıpust, a Define... gombbal. Két alapér-
telmezett peremfeltétel van az ADINA-ban: az egyik az ALL, mely minden lehetséges
szabadságfokot röźıt, illetve a NONE, mely mindent szabadon hagy.

(C) Az alkalmazni ḱıvánt peremfeltétel nevét kiválasztjuk.

(D) A rögźıteni ḱıvánt geometriai, vagy végeselemes csomópont azonośıtóját kell itt elő-
ı́rni.

(E) Ha az alapértelmezett ALL t́ıpustól eltérő elő́ırást akarunk megadni.

A megfogási peremfeltételek létrehozása megadható parancssorból is, melyhez a kö-
vetkező parancs tartozik:

-> FIXBOUNDARY <geometry type>
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1.8. Terhelések

A terhelések elő́ırása a Model→ Loading→ Apply... menüelemmel, vagy a Toolbar-
on lévő ikonnal elérhető dialógusablakban (1.20. ábra) lehetséges.

Terhelést megadhatunk tetszőleges geometriai, vagy végeselemes objektumra (csomó-
pont, elem él, elem lap) a következők szerint:

A A terhelés t́ıpusát kiválasztjuk.

B Ha már létezik definiált terhelés, akkor annak sorszámát itt beálĺıtjuk.

C A Define... gombbal létre kell hozni a ḱıvánt terhelést (nagyság, irány defińıciója).

D Megadjuk, hogy milyen t́ıpusú objektumra ḱıvánunk terhelést elő́ırni.

E A táblázatban meg kell adni a ḱıvánt adatokat.

A táblázat addig nem akt́ıv, amı́g nem választunk ki érvényes Load Number-t, mely-
hez lehetséges, hogy először definiálni kell egy ḱıvánt terhelést.
A táblazatbeli oszlopok fejléce automatikusan változik a kiválasztott terhelési t́ıpus
(Load Type), terhelési hely ( Apply To) függvényében.

1.20. ábra. Terhelések elő́ırása

A feszültségi peremfeltételek létrehozása megadható parancssorból is, melyhez a
következő parancs tartozik:

-> APPLY-LOAD <geometry type>

1.9. Kezdeti feltételek

Az ADINA-ban megadható kezdeti feltételek t́ıpusai:

• hőmérséklet, hőmérséklet változás;

• elmozdulás, sebesség és gyorsulás (elmozdulási és forgási);
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• csőtorzulás és csőgörbülés;

• cső belső nyomás;

• nyúlások és feszültségek.

A konkrét megadási módok tekintetében lásd az ADINA felhasználói kézikönyvet.

1.10. Végeselem háló előálĺıtása

A végeselemes háló definiálása a geometriai modellen történik (Meshing). A következő
háló előálĺıtási technikák használhatók a szoftverben:

• 1D-s elemek: Truss, Beam, Pipe, melyeket geometriai vonalakon és éleken definiál-
hatunk.

• 2D-s elemek: Shell, Plate, 2-D Solid, 2D Fluid, melyeket geometriai felületeken,
vagy lapokon definiálhatunk.

• 3D-s elemek: 3-D Solid, 3-D Fluid, melyeket geometriai térfogatokon vagy teste-
ken definiálhatunk.

A hálózás egy összetett többlépcsős folyamat, mely az ADINA-ban három lépésre van
bontva:

1. Elemcsoportok/halmazok definiálása (elemt́ıpus & paraméterek elő́ırása).

2. A geometria objektumokhoz felosztási sűrűség rendelése (subdivide/seed).

3. A végeselemes háló generálása.

1D-s elemcsalád

Az egydimenziós elemeknek három t́ıpusa van: két-, három- és négycsomópontú elem
(1.21. ábra). Ezek alkalmazása alapvetően a létrehozott elemcsoporttól függ (element
group), például a Hermitian beam elemcsoportnál csak kétcsomópontú elemek használha-
tóak.

1.21. ábra. Egydimenziós elemt́ıpusok

2D-s elemcsalád

A kétdimenziós elemeknél az 1.22. ábrán jelzett t́ıpusok közül lehet választani, melyek
alkalmazása szintén függ a létrehozott elemcsaládtól. Például a plate elemcsaládnál csak
a 3-node háromszögelem használható.

3D-s elemcsalád

A háromdimenziós elemcsaládot a 1.23. ábra mutatja be, melyek alkalmazása attól
függ, hogy milyen t́ıpusú geometria és milyen technikával kerül hálózásra.
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1.22. ábra. Kétdimenziós elemt́ıpusok

1.23. ábra. Háromdimenziós elemt́ıpusok

Elemcsoportok definiálása

Az 1.24. ábrán látható az elemcsoportok létrehozását támogató dialógus ablaka az
ADINA-AUI-ben. Ennek a parancsnak az elind́ıtása kezdeményezhető a Meshing→ Element

Groups... menüelem, vagy a Toolbar-on lévő ikon választásával.

1.24. ábra. Elemcsoport definiálása

Tehát az elemek konkrét létrehozása előtt definiálni kell elemcsoportokat, melyek majd
tartalmazni fogják a létrehozandó elemeket. A fő szerepe az elemcsoport létezésének az,
hogy ez tartalmazza az adott csoportra érvényes közös adatokat, úgymint: anyagmodell
paraméterek, kinematikai feltételezések, numerikus integrációs szabályok, közeĺıtés rendje,
eredmény igények, stb.

A szoftverben elérhető elemcsoportokat az 1.9–1.11. táblázatok sorolják fel néhány
jellemző használati szemponttal. Erről bővebb információt az ADINA kézikönyvben talál-
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hatunk.

A elemcsoportok létrehozása megadható parancssorból is, melyhez a következő pa-
rancs tartozik:

-> EGROUP <type>
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1.9. táblázat. Elemcsoportok az ADINA-ban

Elemcsoport Használati irányelvek
Truss

• A Truss elemek alkalmazhatók kis/nagy alakváltozásos feladatoknál.

• A kétcsomópontos rúdelem (2-node) általában a leghatékonyabb és
modellezhetők vele rúdszerkezetek, kábelszerkezetek, lineáris rugók,
nemlineáris hézagok.

• A három- és négycsomópontos elemek (3-node, 4-node) jól alkal-
mazhatók kábel vagy acél erőśıtések, illetve vasbetonszerkezetek mo-
dellezéséhez, melyek jól együttműködnek, kompatibilisek a maga-
sabb fokú kontinuum, vagy héj elemekkel.

2-D Solid
–> axisymmetric

–> plane stress

–> plane strain

–> 3D plane stress

–> gen p strain

• A kétdimenziós szilárd elemek (2-D Solid) használhatók kis elmoz-
dulások/kis nyúlások, nagy elmozdulások/kis nyúlások, vagy nagy
elmozdulások/nagy nyúlások modellezésekor.

• A 3-D plane stress elemek szerepe akkor lényeges, ha a modelle-
zendő felület (śıkalakváltozásos) nem tehető az Y Z śıkba, ez a modell
az általános 3D térben tetszőlegesen elhelyezhető.

• A tengelyszimmetrikus (axisymmetric), śıkfeszültségi (plane
stress), śıkalakváltozási (plane strain) és az általánośıtott śık-
alakváltozási (genaralized plane strain) elemek kötelezően a
globális Y Z śıkban kell, hogy elhelyezkedjenek. Továbbá a tengely-
szimmetrikus elemek csak a śık +Y felében helyezhetők el, Z forgás-
tengellyel.

• A tengelyszimmetrikus elemek egy radiánt modelleznek a szerke-
zetből. Ezért a koncentrált erő megadásakor erre tekintettel kell
lenni, hogy ez erre vonatkozzon.

• A 9-node elem általában nagyobb hatékonysággal dolgozik, kivéve
a hullámterjedés modellezését.

• A vegyes (mixed displ.-pressure) t́ıpusú elem-formalizmus össze-
nyomhatatlan közegeknél és rugalmas-képlékeny szimulációknál elő-
nyös. Ezen modellekben vagy a 9-node, vagy a 4-node elemeket
alkalmazzuk.

• A 4-node quad és a 3-node trinagular elemek választása javasolt,
ha a vizsgálatnál a hajĺıtó hatások jelentősek.

3-D Solid

• A háromdimenziós elemek használhatók kis elmozdulások/kis nyúlá-
sok, nagy elmozdulások/kis nyúlások, vagy nagy elmozdulások/nagy
nyúlások modellezésekor.

• A 27-node elem használata javasolt a legtöbb esetben, kivéve, ha
hullámterjedési szimulációt folytatunk (ekkor a 8-node elem hasz-
nálata indokolt inkább).

• A vegyes (mixed displ.-pressure) t́ıpusú elem formalizmus össze-
nyomhatatlan közegeknél és rugalmas-képlékeny szimulációknál elő-
nyös. Ezen modellekben vagy a 27-node,s vagy a 8-node elemeket
alkalmazzuk.

• A 8-node brick és a 4-node tetrahedral elemek választása java-
solt, ha a szimulációban a hajĺıtó hatások jelentős mértékűek.
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1.10. táblázat. Elemcsoportok az ADINA-ban (folytatás)

Elemcsoport Használati irányelvek
Beam
–> 2-D

–> 3-D • Euler-Bernoulli-féle rúdmodell.

• A beam elem egy 2-node Hermitian beam állandó – felhasználó ál-
tal megadott – keresztmetszetű rúdelem. A rúd viselkedése léırható
egyrészt a keresztmetszet és az anyag definiálásával, másrészt pedig
nyomaték-görbület összetartozó értékpárok megadásával.

• A 2-D beam elemeket kötelezően a globális XY , XZ vagy Y Z śıkok-
ban kell elhelyezni.

• A beam elemek használhatók kis és nagy elmozdulásoknál egyaránt,
viszont a kis nyúlások feltételezettek ezen elemmodel akalamazása-
kor.

• Minden ADINA-beli keresztmetszet t́ıpus használható a rugalmas
beam elemeknél, csak arra kell tekintettel lenni, hogy a nemlineáris
rugalmas-képlékeny szimulációknál csak a négyszög és kör kereszt-
metszetek választhatók.

Isobeam
–> general 3-D

–> plane stress

–> plane strain

–> axisym. shell

• Timoshenko-féle rúdmodell.

• Ezen elemeknek kötelezően az Y Z śıkban kell elhelyezkedniük, kivéve
a general 3-D t́ıpust. A tengelyszimmetrikus isobeam elemek pedig
csak a +Y śıkban lehetnek.

• Csak a téglalap keresztmetszet használható az isobeam elemekkel.

• Egy radián kerül modellezésre a tengelyszimmetrikus isobeam elem-
t́ıpusnál.

• Kis, vagy nagy elmozdulások, de csak kis nyúlások esetén használ-
ható.

• Használatuk elsősorban a következőkben javasolt: görbe rudak, hé-
jak merev́ıtése, nagy alakváltozásos rudak, tengelyszimmetrikus héjak
tengelyszimmetrikus terhelés esetén.

Plate

• Ez az elem egy 3-node flat triangular/śıkbeli elem, melyet gyak-
ran alkalmaznak vékony lemezek és héjak modellezéséhez.

• Elmozdulások lehetnek kicsik és nagyok, azonban az alakváltozások
csak kicsik lehetnek.

• Csak ritkán alkalmazzák ezen elemcsaládot.

Shell

• A héjelemek alkalmazhatók kis/nagy elmozdulások valamint
kis/nagy alakváltozások esetén is. Fontos azonban, hogy a nagy el-
mozdulásos és nagy alakváltozásos formalizmus csak bizonyos anyag-
modellek esetében használható.

• A leghatékonyabb elemt́ıpus ebben a csoportban a 4-node héjelem,
mely jórészt ”locking” mentes és hatékonyan dolgozik a vékony és
vastag héjak esetében is.

• Ez az elemcsalád alkalmas kompozit szerkezetek esetében is.
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1.11. táblázat. Elemcsoportok az ADINA-ban (folytatás)

Elemcsoport Használati irányelvek
Pipe

• A pipe elemek használhatók a 2-node és 4-node változatban is, ha
nem jelenik meg ovalitás, vagy csavarodás, ellenkező esetben csak a
4-node csőelem javasolt.

• Csőszerkezetek modellezésére alkalmas elsősorban, értelmezhető rá a
belső nyomás és hőmérsékleti elő́ırás is.

• Ha nincs jelentős ovalitási torzulás akkor, lineáris és nemlineáris vi-
selkedés is modellezhető vele nagy elmozdulásokkal, de kis alakvál-
tozásokkal.

• Ha ovalitás is jellemző a modellre, akkor a 4-node pipe elemnél a
kis elmozdulás és alakváltozás egyaránt feltételezett.

General

• Az általános elemek lineárisak, melyek tetszőleges számú csomópon-
tot tartalmazhatnak.

• Bizonyos speciális modellezési igény esetén használatosak, amikor
egy-egy formalizmus nem érhető el az ADINA-ban.

• A felhasználó közvetlenül megadhatja az elemhez tartozó merevségi
mátrixot (vagy dinamikai feladatnál a tömeg, és csillaṕıtási mátri-
xokat is).

Spring

• A spring/rugó elem két csomópontot, vagy egy csomópontot és a
földet kötheti össze.

• Lineáris és nemlineáris rugó is definiálható.

• Ezen elemek nem kezelhetőek együtt a többi elem definiálásával.
-> Meshing → Elements → Spring...

2-D Fluid
–> axisymmetric

–> planar
• A 2-D Fluid elemeknek a globális Y Z śıkban kell feküdni, a ten-

gelyszimmetrikus t́ıpusoknak pedig a +Y śıkrészben.

• Elmozdulás alapú folyadék elemek vagy potenciál alapú folyadék ele-
mek definiálhatók. Azonban ez utóbbi alkalmazása jóval gyakoribb
és inkább ajánlható.

• Ezen elemekről bővebben lásd az ADINA kézikönyvet.

3-D Fluid

• Elmozdulás alapú folyadék elemek vagy potenciál alapú folyadék ele-
mek definiálhatók. Azonban ez utóbbi alkalmazása jóval gyakoribb
és inkább ajánlható.

• Ezen elemekről bővebben lásd az ADINA kézikönyvet.
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Felosztási sűrűség megadása subdivision/seed

Attól függően, hogy milyen t́ıpusú geometrián ḱıvánjuk elő́ırni a felosztási sűrűsé-
get, más-más Meshing → Mesh Density → <geometry type> menüparancsot és Tool-
bar ikont kell választanunk ( ).

Az AUI-ben alkalmazott hálózási stratégia alapját az adja, hogy a modell vonalait, ha-
tároló éleit felosztási sűrűséggel látjuk el (megadjuk az éleken található elemek méretét).
Az alapértelmezett felosztás szerint minden egyes él ”egy részre van felosztva”. Tehát ál-
talában igaz az, hogy ennél finomabb felosztási sűrűség megadása szükséges a geometriára
a hálózás előtt.

Hálósűrűség definiálható geometriai pontra, vonalra, felületre, térfogatra, élre, lapra
és testre. De globálisan, az egész modellre is elő́ırható hálósűrűség.

Az aktuálisan érvényes hálózási sűrűség megjeleńıtődik az éleken, ahogy ezt az 1.25. ábra
jelzi.

1.25. ábra. Hálósűrűség jelzése

Háromféle módszer van egy geometria elemsűrűségének elő́ırásához, ezeket sorolja fel
az 1.12. táblázat.

A felosztási sűrűség definiálása megadható parancssorból is, melyhez a következő
parancs tartozik:

-> SUBDIVIDE <geometry type>
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1.12. táblázat. Felosztási sűrűség megadása

Felosztási
módszer

Léırás

Use Length

• Az elem élének a hosszát adjuk meg (elemek méretét) a geomet-
riai vonalak, élek mentén.

• A felosztási sűrűség egyenletes méretű lesz.

• Ez a legegyszerűbb módja a hálósűrűség geometriához való hoz-
zárendelésének.

Use Number of
Divisions • A felosztási számot (elemek számát) rendeljük a geometriai vo-

nalhoz, élhez.

• Amikor vonalhoz, felülethez, térfogathoz, vagy élhez rendeljük
ezt hozzá, akkor lehetőség van a felosztási hosszt is vezérelni
(biasing). Választhatunk az alapértelmezett End Biasing, vagy
a Center Biasing lehetőségek között.

• Ez jelenti általában a leghatékonyabb módját annak, hogy a
hálósűrűséget hozzárendeljük a modellhez.

Use End-Point
Sizes • A hálósűrűség a geometriai vonalak, vagy élek végpontjaihoz

rendelt sűrűségértékekből határozódik meg.

• Az elemhossz a vonal, vagy él mentén aszerint változik, hogy
milyen sűrűség érték van hozzárendelve az él végpontjaihoz.

• Ennél a módszernél csak a végpontokhoz szükséges sűrűségérté-
keket definiálni.
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Hálógenerálás, törlés

A háló generálása hozza létre a végeselemeket a ḱıvánt geometriai térfogatokon, felü-
leteken, vonalakon, vagy testeken, lapokon, éleken. A késźıtendő elemháló t́ıpusa (truss,
beam, 2-D solid, shell, 3-D solid, fluid) attól függ, hogy milyen elemcsoportot
jelölünk be a háló késźıtésekor.

Az 1.13. táblázat a lehetséges hálózási technikákat és elemcsoportokat rendszerezi.

1.13. táblázat. Hálógenerálás

Hálógeometria Elemcsoport lehetőségek
Mesh Line
–> GLINE

Mesh Edge
–> GEDGE

• Truss

• Beam

• Isobeam

• Pipe

• 2-D Fluid Interface

• General

Mesh Surface
–> GSURFACE

Mesh Face
–> GFACE

• 2-D Solid

• Plate

• Shell

• 2-D Fluid

• 3-D Fluid Interface

• General

Mesh Volume
–> GVOLUME

Mesh Body
–> GBODY

• 3-D Solid

• 3-D Fluid

• General

A hálógenerálisi technikákról részletesebben lásd az ADINA kézikönyvet.
A végeselemes háló törlése a Meshing → Delete Mesh... menüparanccsal vagy

a ikonnal elérhető dialógusablak seǵıtségével lehet. Ezen azt kell megadni, hogy mely
t́ıpusú geometriákról ḱıvánjuk eltávoĺıtani a hálót, valamint azt, hogy mely elemcsoport-
hoz tartoznak a törlendő elemek, valamint, ha a t́ıpusa szerint a háló élhez, vagy laphoz
tartozik, akkor azt is definiálni kell, hogy melyik testhez való tartozásról van szó.

Az is megadható, hogy a törölni ḱıvánt elemhez tartozó csomópontokat is törölni
ḱıvánjuk-e (Delte Corresponting Nodes).

A háló törlése megadható parancssorból is, melyhez a következő parancs tartozik:

-> EDELETE <geometry type>
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1.11. A szimuláció/Solution

Ez lépés az, amely a grafikus környezetben, vagy esetleg kézzel előálĺıtott modellhez ki-
számı́tja a numerikus megoldást. Az AUI felületen ez két lépést jelent, előálĺıtjuk az input
file-t (.dat), majd futtatjuk a szimulációt. Ez az adatfile az ADINA végeselemes megoldó-
jának az input állományát jelenti, generálása a grafikus felhasználói felületről kényelmesen
megtehető, azonban, ha valamilyen hiányosság, vagy hiba van az AUI adatbázisban, akkor
ez a (.dat) file nem kerül előálĺıtásra.

1.26. ábra. A szimuláció ind́ıtása

Az 1.26. ábrán látható dialógusablak seǵıtségével álĺıtjuk be a ḱıvánt szimulációs pa-
ramétereket (processzorok száma, használható memória, stb.), melynek elind́ıtásához a
Solution → Datafile/Run... menüelemmel vagy a Toolbar-on lévő ikon seǵıtségé-
vel jutunk.

Ezen a dialóguson csak az adatfile létrehozása az elsődleges feladat, a szimuláció végre-
hajtását az B-vel jelölt opció bekapcsolásával lehet kezdeményezni. Ezen lehetőség azonban
sok esetben okozhat nehézséget, pl. ADINA-FSI vagy ADINA-TMC modellek vizsgálatakor,
vagy viszonylag nagyméretű, hosszú futásidejű problémáknál, ekkor jobb csak az input
.dat állomány generálása és a futtatást egy következő lépésben, az AUI bezárása után
érdemes elind́ıtani.

Memória beálĺıtás

Az 1.26. ábrán jelzett dialógusablak D mezőjében a szimuláció során használható ma-
ximális memóriát ı́rjuk elő, ez magába foglalja azt a memóriamennyiséget is, amelyet az
egyenletrendszer-megoldó használhat. Ha ez a mező 0 értéket definiál, akkor az jelzi a
szoftvernek, hogy a program szabadon gazdálkodhat a rendelkezésre álló memóriával.

Az E-vel jelölt sorban a modell memóriabeli tárolásához biztośıthatunk helyet. Ha a
sparse/ritkamátrix megoldó kerül felhasználásra a szimulációkor, akkor ehhez a területhez
még a szoftver fog memóriát foglalni az in-core megoldás érdekében.

FONTOS. Nagyméretű feladatoknál sokkal hasznosabb out-of-core megoldót alkal-
mazni (mely a valóságos fizikai memóriát ćımezi), mint olyan in-core megoldóval
számolni, mely végül a háttértáron dolgozik, a virtuális memóriában.
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A számı́tások futtatása parancsfile-ból az <ADINAHOME>/tools jegyzékben található
programmal lehetséges:

–> adinaN.n <options> <data filename>

ahol az N.n a szoftver verziószámára utal, a -h kacsolóval listát kapunk az elérhető,
beálĺıtható opciókról.

1.12. A Post Processing

A szimuláció végrehajtása után lehetőség nýılik az eredmények feldolgozására (Post-
Processing). A szoftver ezen részének elérése a Module Bar seǵıtségével lehetséges a Post
Processing kiválasztásával.

Az eredményeket a szimuláció során egy porthole (.port) file-ba ı́rja ki a szoftver,
melyet először meg kell nyitni az AUI-ben a menüből a File → Open..., vagy Ctrl-

O billentyűkombinációval, vagy a ikon seǵıtségével. A porthole állomány megnyitása
után a deformált modell jelenik meg kirajzolva az utolsó időlépésben kapott eredményeket.

Az eredmények vizsgálata, a modell elemzése egy viszonylag összetett és hosszú fo-
lyamat. Az ADINA ehhez többféle lehetőséggel rendelkezik melyeket röviden a következő
felsorolási adja meg:

• Deformed Plot .

• Band Plot.

• Vector Plot.

• Cut Surface.

• Results along a line, azaz egy adott vonal mentén rajzoljuk ki a kapott adatokat.

• Response at a point, azaz a modell vizsgálata az időben történt változások tekin-
tetében. Ez egyfajta történeti fejlődése a modellnek.

• Definiálható ún. Resultant Variable.

• Késźıthetünk animációkat a számı́tásokról. Animation movie.

Ezen lehetőségekről itt nem ı́runk hosszabban. Bővebb információ érdekében lásd az
ADINA on-line kézikönyv megfelelő fejezeteit.

1.13. Felhasznált irodalom, dokumentáció

[1] Online dokumentáció, AUI: Commands for ADINA: ARD 08-2, February 2008

[2] Online példatár, ADINA AUI Primer: ARD 08-6, February 2008

[3] ADINA Theory and Modeling Guide: ARD 08-7, February 2008

[4] AUI Help HTML documentation. ADINA menü: Help → Index(html)...



2. rész

Húzott-nyomott rúd vizsgálata

Feladat az 2.1. ábrán vázolt szerkezet végeselemes modelljének feléṕıtése. A vizs-
gált tartónak az ábrán vázolt állandó, téglalap keresztmetszete van, anyaga acél (Linear-
Elastic, Isotropic):

E = 205 GPa ν = 0.28

A modell feléṕıtésekor húzott-nyomott rúdelem kerüljön alkalmazásra!
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2.1. ábra. A vizsgált befogott rúd

Határozzuk meg a támasztó ER-t, illetve a rúderőket, a rúd elmozdulásait és a rúdban
ébredő húzófeszültséget!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából:

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak x irányú elmozdulás van

Geometry → Points... 1: 0,0,0; 2: 1,0,0;

→ Lines → Define... Straight 1: P1, P2

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 2.05e11; Poisson’s Ratio: 0.28

→ Boundary Conditions → Apply Fixity Points, ALL

→ Loading → Apply...

Define (No.1), Magnitude: 800, irány: +x
Points, Site#: 1

Meshing → Element Groups

Add...; Type: TRUSS, Default Section Area: 0.0006

→ Mesh Density → Line...

Use Number of Divisions: 4

→ Create Mesh → Line...

TRUSS, Line#: 1

Solution → Data File/Run...
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AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

List → Extreme Values

DISPLACEMENT: 1-Dispacement

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Element Line Plot → Create...

Axial Force, Strain, Stress

→ Band Plot → Create...

DISPLACEMENT. Apply

→ Animate



40 2. RÉSZ: Húzott-nyomott rúd vizsgálata

DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak 01. TRUSS problem’
*--- Database saved 8 September 2009, 13:47:15 ---*
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=11111 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 1.00000000000000 0.00000000000000 0.00000000000000 0
@
*
LINE STRAIGHT NAME=1 P1=1 P2=2
*
MATERIAL ELASTIC NAME=1 E=2.05000000000000E+11 NU=0.280000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=,
’Elastic - isotropic - steel’
*
FIXBOUNDARY POINTS FIXITY=ALL
@CLEAR
1 ’ALL’
@
*
LOAD FORCE NAME=1 MAGNITUD=800.000000000000 FX=1.00000000000000,

FY=0.00000000000000 FZ=0.00000000000000
*
APPLY-LOAD BODY=0
@CLEAR
1 ’FORCE’ 1 ’POINT’ 2 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TRUSS NAME=1 SUBTYPE=GENERAL DISPLACE=DEFAULT MATERIAL=1,

INT=DEFAULT GAPS=NO INITIALS=NONE CMASS=DEFAULT,
TIME-OFF=0.00000000000000 OPTION=NONE RB-LINE=1 DESCRIPT=,

’Truss elements with cross section area: 0.0006m’,
AREA=0.000600000000000000 PRINT=DEFAULT SAVE=DEFAULT,
TBIRTH=0.00000000000000 TDEATH=0.00000000000000 TMC-MATE=1

*
GLINE NODES=2 NCOINCID=ENDS NCENDS=12 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=1 MIDNODES=CURVED
@CLEAR
1
@
*



3. rész

Hajĺıtott-nýırt tartó

Feladat az 3.1. ábrán vázolt szerkezet végeselemes modelljének feléṕıtése. A vizs-
gált tartó egy acélcső (Linear-Elastic, Isotropic), 50.8 mm-es külső átmérővel, 10 mm-es
falvastagsággal.

E = 185 GPa ν = 0.25

A modell feléṕıtésekor hajĺıtott-nýırt rúdelem kerüljön alkalmazásra!
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3.1. ábra. A vizsgált befogott rúd

Határozzuk meg a támasztó ER-t, illetve a rúderőket, a rúd elmozdulásait!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából:

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak x, y irányú elmozdulás és z irányú forgás van (ha
az alapértelmezett x− y śıkon vagyunk)

Geometry → Points... 1: 0,0,0; 2: 1000,0,0; 3: 0,100,0;

→ Lines → Define... Straight 1: P1, P2

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 185E3; Poisson’s Ratio: 0.28

→ Element Properties → Cross Sections...

Add... Type: Pipe, Diameter D: 50.8; Thickness T: 10

→ Boundary Conditions → Apply Fixity Points, ALL

→ Loading → Apply...

Type: Distributed Line Load, Define (No.1) , Magnitude: 10

Apply to: Line, Site#: 1 Aux. Point: 3

Meshing → Element Groups...

Add...; Type: BEAM, Cross Section: 1

→ Mesh Density → Line...

Use Number of Divisions: 20

→ Create Mesh → Line...

BEAM, Line#: 1

Solution → Data File/Run...
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42 3. RÉSZ: Hajĺıtott-nýırt tartó

DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak. 02: BEAM - model’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=1110 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 1000.00000000000 0.00000000000000 0.00000000000000 0
3 0.00000000000000 100.000000000000 0.00000000000000 0
@
*
LINE STRAIGHT NAME=1 P1=1 P2=2
*
MATERIAL ELASTIC NAME=1 E=1.85000000000000E+05 NU=0.250000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=,
’Linear Elastic Material’
*
CROSS-SECTIO PIPE NAME=1 DIAMETER=50.8000000000000,

THICKNES=10.0000000000000 SC=0.00000000000000,
TC=0.00000000000000 TORFAC=1.00000000000000,
SSHEARF=0.00000000000000 TSHEARF=0.00000000000000 SOLID=NO

*
FIXBOUNDARY POINTS FIXITY=ALL
@CLEAR
1 ’ALL’
@
*
LOAD LINE NAME=1 MAGNITUD=10.0000000000000
*
APPLY-LOAD BODY=0
@CLEAR
1 ’LINE’ 1 ’LINE’ 1 0 1 0.00000000000000 0 -1 3 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP BEAM NAME=1 SUBTYPE=THREE-D DISPLACE=DEFAULT MATERIAL=1 RINT=5,

SINT=DEFAULT TINT=DEFAULT RESULTS=STRESSES INITIALS=NONE,
CMASS=DEFAULT RIGIDEND=NONE MOMENT-C=NO RIGIDITY=1,
MULTIPLY=1000000.00000000 RUPTURE=ADINA OPTION=NONE,
BOLT-TOL=0.0100000000000000 DESCRIPT=’NONE’ SECTION=1,
PRINT=DEFAULT SAVE=DEFAULT TBIRTH=0.00000000000000,
TDEATH=0.00000000000000 SPOINT=4 BOLTFORC=0.00000000000000,
BOLTNCUR=0 TMC-MATE=1

*
SUBDIVIDE LINE NAME=1 MODE=DIVISIONS NDIV=20 RATIO=1.00000000000000,

PROGRESS=GEOMETRIC CBIAS=NO
*
GLINE NODES=2 AUXPOINT=3 NCOINCID=ENDS NCENDS=12,

NCTOLERA=1.00000000000000E-05 SUBSTRUC=0 GROUP=1 MIDNODES=CURVED
@CLEAR
1
@
*



4. rész

Rácsos tartó vizsgálata I.

Feladat az 4.1. ábrán vázolt szerkezet végeselemes modelljének feléṕıtése. A vizsgált
tartó rúdjai 2

′′
-os acélcsövek (Linear-Elastic, Isotropic), 10 mm-es falvastagsággal.

2a

α

F0
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x

y

4.1. ábra. A vizsgált rácsos szerke-
zet

α = 30◦ a = 1000 mm
E = 180 GPa ν = 0.3 F0 = 10 kN
A modell feléṕıtésekor csak húzott-
nyomott rúdelem kerüljön alkalmazásra!
Határozzuk meg a támasztó erőket, rúd-
erőket, illetve a rudak elmozdulásait és a
bennük ébredő húzó-, nyomófeszültséget!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából:
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44 4. RÉSZ: Rácsos tartó vizsgálata I.

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak x, y irányú elmozdulás és z irányú forgás van

Geometry → Points... 1: 0,0,0; 2: 1000,0,0; 3: 0,1732.05,0

→ Lines → Define...

Add... Straight 1: P1, P2 Save

Add... Straight 2: P2, P3 Save

Add... Straight 3: P3, P1 Save

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 180e3; Poisson’s Ratio: 0.3

→ Boundary Conditions → Define Fixity...

Add... 1: NO-XY-TRANS x, y translation-t bejelölni
Add... 2: NO-Y-TRANS y translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

Point# 1: NO-XY-TRANS

Point# 2: NO-Y-TRANS

→ Loading → Apply...

Define (No.1), Magnitude: 10000, Force Direction x : 0.866, y : 0.5
Points, Site#: 3

Meshing → Element Groups...

Add...; Type: TRUSS, Default Section Area: 1281.77

→ Create Mesh → Line...

TRUSS, Line#: 1 2 3

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Extreme Values

DISPLACEMENT: 1-Dispacement DISPLACEMENT: 2-Dispacement

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Element Line Plot → Create...

Axial Force, Strain, Stress

→ Reaction Plot → Create...

REACTION. Apply

→ Band Plot → Create...

DISPLACEMENT. Apply

→ Animate
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DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak 04: - Truss Problem (racsos tarto)’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=1110 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 1000.00000000000 0.00000000000000 0.00000000000000 0
3 0.00000000000000 1732.05000000000 0.00000000000000 0
@
*
LINE STRAIGHT NAME=1 P1=1 P2=2
*
LINE STRAIGHT NAME=2 P1=2 P2=3
*
LINE STRAIGHT NAME=3 P1=1 P2=3
*
MATERIAL ELASTIC NAME=1 E=180000.000000000 NU=0.300000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
FIXITY NAME=NO-XY-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Z-TRANSLATION’
’X-ROTATION’
’Y-ROTATION’
’OVALIZATION’
@
*
FIXITY NAME=NO-Y-TRANS
@CLEAR
’Y-TRANSLATION’
’Z-TRANSLATION’
’X-ROTATION’
’Y-ROTATION’
’OVALIZATION’
@
*
FIXBOUNDARY POINTS FIXITY=ALL
@CLEAR
1 ’NO-XY-TRANS’
2 ’NO-Y-TRANS’
@
*
LOAD FORCE NAME=1 MAGNITUD=10000.0000000000 FX=0.866000000000000,

FY=0.500000000000000 FZ=0.00000000000000
*
APPLY-LOAD BODY=0
@CLEAR
1 ’FORCE’ 1 ’POINT’ 3 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
APPLY-LOAD BODY=0
@CLEAR
1 ’FORCE’ 1 ’POINT’ 3 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TRUSS NAME=1 SUBTYPE=GENERAL DISPLACE=DEFAULT MATERIAL=1,

INT=DEFAULT GAPS=NO INITIALS=NONE CMASS=DEFAULT,
TIME-OFF=0.00000000000000 OPTION=NONE RB-LINE=1 DESCRIPT=’NONE’,
AREA=1281.77000000000 PRINT=DEFAULT SAVE=DEFAULT,
TBIRTH=0.00000000000000 TDEATH=0.00000000000000 TMC-MATE=1

*
GLINE NODES=2 NCOINCID=ENDS NCENDS=12 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=1 MIDNODES=CURVED
@CLEAR
1
2
3



46 4. RÉSZ: Rácsos tartó vizsgálata I.

@
*
GLINE NODES=2 NCOINCID=ENDS NCENDS=12 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=1 MIDNODES=CURVED
****



5. rész

Rácsos tartó vizsgálata II.

Feladat az 5.1. ábrán vázolt szerkezet végeselemes modelljének feléṕıtése. A vizsgált
tartó v́ızszintes rúdjai 4×6 mm keresztmetszetű acélrudak, mı́g a többi rúd 3 mm átmérőjű
acélhuzal (Linear-Elastic, Isotropic) (E = 100 GPa, ν = 0.2).

A modell feléṕıtésekor csak húzott-nyomott rúdelem kerüljön alkalmazásra!
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120 N 80 N
5.1. ábra. A vizsgált rácsos szerkezet

Határozzuk meg a támasztó erőket, rúderőket, illetve a rudak elmozdulásait és a ben-
nük ébredő húzó-, nyomófeszültséget!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából:
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48 5. RÉSZ: Rácsos tartó vizsgálata II.

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak x, y irányú elmozdulás és z irányú forgás van

Geometry → Points... 1: 0,0,0; 2: 40,0,0; 3: 80,0,0; 4: 120,0,0; 5: 160,0,0; 6: 40,30,0; 7:
80,30,0; 8: 120,30,0;

→ Lines → Define...

Add... Straight 1: P1, P2 Save

Add... Straight 2: P2, P3 Save

Add... Straight 3: P3, P4 Save

Add... Straight 4: P4, P5 Save

Add... Straight 5: P6, P7 Save

Add... Straight 6: P7, P8 Save

Add... Straight 7: P1, P6 Save

Add... Straight 8: P2, P6 Save

Add... Straight 9: P3, P7 Save

Add... Straight 10: P4, P8 Save

Add... Straight 11: P5, P8 Save

Add... Straight 12: P3, P6 Save

Add... Straight 13: P3, P8 Save

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 100e3; Poisson’s Ratio: 0.2

→ Boundary Conditions → Define Fixity...

Add... 1: NO-XY-TRANS x, y translation-t bejelölni
Add... 2: NO-Y-TRANS y translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

Point# 1: NO-XY-TRANS

Point# 5: NO-Y-TRANS

→ Loading → Apply...

Define (No.1), Magnitude: 120, Force Direction x : 0, y : −1
Points, Site#: 2

→ Loading → Apply...

Define (No.2), Magnitude: 80, Force Direction x : 0, y : −1
Points, Site#: 3

Meshing → Element Groups...

Add... (No.1); Type: TRUSS, Default Section Area: 24
Add... (No.2); Type: TRUSS, Default Section Area: 7.069

→ Create Mesh → Line...

TRUSS, Element Group - No.1 Line#: 1 2 3 4 5 6

TRUSS, Element Group - No.2 Line#: 7 8 9 10 11 12 13

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Extreme Values

DISPLACEMENT: 1-Dispacement DISPLACEMENT: 2-Dispacement

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Element Line Plot → Create...

Axial Force, Strain, Stress

→ Reaction Plot → Create...

REACTION. Apply

→ Band Plot → Create...

DISPLACEMENT. Apply

→ Animate

List → Value List → Zone

Zone Name: EG1 Variables to List: Force, FORCE-R

Zone Name: EG2 Variables to List: Force, FORCE-R

Zone Name: EG1 Variables to List: Stress, EFFECTIVE_STRESS

Zone Name: EG2 Variables to List: Stress, EFFECTIVE_STRESS
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DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak 05 - Racsos tarto, Truss problem’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=1110 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*--- Database saved 17 September 2009, 13:24:12 ---*
*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 40.0000000000000 0.00000000000000 0.00000000000000 0
3 80.0000000000000 0.00000000000000 0.00000000000000 0
4 120.000000000000 0.00000000000000 0.00000000000000 0
5 160.000000000000 0.00000000000000 0.00000000000000 0
6 40.0000000000000 30.0000000000000 0.00000000000000 0
7 80.0000000000000 30.0000000000000 0.00000000000000 0
8 120.000000000000 30.0000000000000 0.00000000000000 0
@
*
LINE STRAIGHT NAME=1 P1=1 P2=2
*
LINE STRAIGHT NAME=2 P1=2 P2=3
*
LINE STRAIGHT NAME=3 P1=3 P2=4
*
LINE STRAIGHT NAME=4 P1=4 P2=5
*
LINE STRAIGHT NAME=5 P1=6 P2=7
*
LINE STRAIGHT NAME=6 P1=7 P2=8
*
LINE STRAIGHT NAME=7 P1=1 P2=6
*
LINE STRAIGHT NAME=8 P1=2 P2=6
*
LINE STRAIGHT NAME=9 P1=3 P2=7
*
LINE STRAIGHT NAME=10 P1=4 P2=8
*
LINE STRAIGHT NAME=11 P1=5 P2=8
*
LINE STRAIGHT NAME=12 P1=3 P2=6
*
LINE STRAIGHT NAME=13 P1=3 P2=8
*
MATERIAL ELASTIC NAME=1 E=100000.000000000 NU=0.200000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
FIXITY NAME=NO-XY-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Z-TRANSLATION’
’X-ROTATION’
’Y-ROTATION’
’OVALIZATION’
@
*
FIXITY NAME=NO-Y-TRANS
@CLEAR
’Y-TRANSLATION’
’Z-TRANSLATION’
’X-ROTATION’
’Y-ROTATION’
’OVALIZATION’
@
*
FIXBOUNDARY POINTS FIXITY=ALL
@CLEAR
1 ’NO-XY-TRANS’
5 ’NO-Y-TRANS’
@
*
LOAD FORCE NAME=1 MAGNITUD=120.000000000000 FX=0.00000000000000,
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FY=-1.00000000000000 FZ=0.00000000000000
*
LOAD FORCE NAME=2 MAGNITUD=80.0000000000000 FX=0.00000000000000,

FY=-1.00000000000000 FZ=0.00000000000000
*
APPLY-LOAD BODY=0
@CLEAR
1 ’FORCE’ 1 ’POINT’ 2 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
2 ’FORCE’ 2 ’POINT’ 3 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TRUSS NAME=1 SUBTYPE=GENERAL DISPLACE=DEFAULT MATERIAL=1,

INT=DEFAULT GAPS=NO INITIALS=NONE CMASS=DEFAULT,
TIME-OFF=0.00000000000000 OPTION=NONE RB-LINE=1 DESCRIPT=,

’horizontal truss’ AREA=24.0000000000000 PRINT=DEFAULT SAVE=DEFAULT,
TBIRTH=0.00000000000000 TDEATH=0.00000000000000 TMC-MATE=1

*
EGROUP TRUSS NAME=2 SUBTYPE=GENERAL DISPLACE=DEFAULT MATERIAL=1,

INT=DEFAULT GAPS=NO INITIALS=NONE CMASS=DEFAULT,
TIME-OFF=0.00000000000000 OPTION=NONE RB-LINE=1 DESCRIPT=,

’Vertical truss’ AREA=7.06900000000000 PRINT=DEFAULT SAVE=DEFAULT,
TBIRTH=0.00000000000000 TDEATH=0.00000000000000 TMC-MATE=1

*
GLINE NODES=2 NCOINCID=ENDS NCENDS=12 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=1 MIDNODES=CURVED
@CLEAR
1
2
3
4
5
6
@
*
GLINE NODES=2 NCOINCID=ENDS NCENDS=12 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=2 MIDNODES=CURVED
@CLEAR
7
8
9
10
11
12
13
@
*
GLINE NODES=2 NCOINCID=ENDS NCENDS=12 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=2 MIDNODES=CURVED



6. rész

Śıkbeli tartószerkezet I.

Adott a következő ”C” -állvány feladat:

z
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1 m

1 m2

m

b

0.
8

m
0.

2

m

0.
8

m

p

3 m

6.1. ábra. ”C” állvány

Az állvány anyaga általános acél (Linear-Elastic, Isotropic).

E = 110 GPa ν = 0.2

Az állványzat állandó vastagsága:

b = 100 mm.

A megoszló terhelés intenzitása a jelzett vonalon:

p = 10
N

mm
.

Határozzuk meg a fenti ábrán jelzett peremfeltételek mellett a ”C” állvány veszélyes
helyét (helyeit), továbbá azon helyeken a maximális feszültségek értékét!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából:
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P1 P2 P3

P4P5

P6 P7

P8 P9

P10P11P12P13

B B

S1

S2

S3

S4

B B B B B BB B B B B B B B B B B B B B BB B B B B B B B B B

U
2

U
3 1

B - -

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

6.2. ábra. ”C” állvány VEM modellje
AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak y, z irányú elmozdulás és x irányú forgás van

Geometry → Points... 1: 0,0,0; 2: 0,1000,0; 3: 0,3000,0; 4: 0,3000,800; 5: 0,1000,800; 6:
0,1000,1000; 7: 0,2000,1000; 8: 0,2000,1200; 9: 0,3000,1200; 10: 0,3000,2000;
11: 0,2000,2000; 12: 0,1000,2000; 13: 0,0,2000;

→ Surfaces → Define...

Add... Vertex 1: P1, P2, P12, P13 Save

Add... Vertex 2: P2, P3, P4, P5 Save

Add... Vertex 3: P6, P7, P11, P12 Save

Add... Vertex 4: P8, P9, P10, P11 Save

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 110e3; Poisson’s Ratio: 0.2

→ Boundary Conditions → Define Fixity...

Add... 1: NO-YZ-TRANS y, z translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

Lines# 1: NO-YZ-TRANS

Lines# 5: NO-YZ-TRANS

→ Loading → Apply...

Define (No.1), Magnitude: 10, Pressure
Line, Site#: 13

Meshing → Element Groups...

Add... (No.1); Type: 2D-Solid, Element Sub-Type: Plane Stress, Defa-

ult Element Thickness: 100

→ Mesh Density → Surface

Method: Use Length, Element Edge Length: 200

Surface: 1,2,3,4

→ Create Mesh → Surface...

2-D Solid, Element Group - No.1 Surface#: 1 2 3 4

Solution → Data File/Run...
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AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Displacement, Stress, stb.

→ Animate

DISP MAG 32.93

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

DISPLACEMENT
MAGNITUDE

TIME 1.000

9.333
8.667
8.000
7.333
6.667
6.000
5.333
4.667
4.000
3.333
2.667
2.000
1.333
0.667
0.000

MAXIMUM
9.896

NODE 546

MINIMUM
0.000

NODE 1

6.3. ábra. ”C” állvány abs. elmozdulás
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DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak-06a: Plane stress problem (SF) simple’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=100011 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 1000.00000000000 0.00000000000000 0
3 0.00000000000000 3000.00000000000 0.00000000000000 0
4 0.00000000000000 3000.00000000000 800.000000000000 0
5 0.00000000000000 1000.00000000000 800.000000000000 0
6 0.00000000000000 1000.00000000000 1000.00000000000 0
7 0.00000000000000 2000.00000000000 1000.00000000000 0
8 0.00000000000000 2000.00000000000 1200.00000000000 0
9 0.00000000000000 3000.00000000000 1200.00000000000 0
10 0.00000000000000 3000.00000000000 2000.00000000000 0
11 0.00000000000000 2000.00000000000 2000.00000000000 0
12 0.00000000000000 1000.00000000000 2000.00000000000 0
13 0.00000000000000 0.00000000000000 2000.00000000000 0
@
*
SURFACE VERTEX NAME=1 P1=1 P2=2 P3=12 P4=13
*
SURFACE VERTEX NAME=2 P1=2 P2=3 P3=4 P4=5
*
SURFACE VERTEX NAME=3 P1=6 P2=7 P3=11 P4=12
*
SURFACE VERTEX NAME=4 P1=8 P2=9 P3=10 P4=11
*
MATERIAL ELASTIC NAME=1 E=110000.000000000 NU=0.200000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
FIXITY NAME=YZ-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Z-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
@
*
FIXBOUNDARY LINES FIXITY=ALL
@CLEAR
1 ’YZ-TRANS’
5 ’YZ-TRANS’
@
*
LOAD PRESSURE NAME=1 MAGNITUD=10.0000000000000 BETA=0.00000000000000,

LINE=0
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’LINE’ 13 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TWODSOLID NAME=1 SUBTYPE=STRESS2 DISPLACE=DEFAULT,

STRAINS=DEFAULT MATERIAL=1 INT=DEFAULT RESULTS=STRESSES,
DEGEN=YES FORMULAT=0 STRESSRE=GLOBAL INITIALS=NONE FRACTUR=NO,
CMASS=DEFAULT STRAIN-F=0 UL-FORMU=DEFAULT PNTGPS=0 NODGPS=0,
LVUS1=0 LVUS2=0 SED=NO RUPTURE=ADINA INCOMPAT=DEFAULT,
TIME-OFF=0.00000000000000 POROUS=NO WTMC=1.00000000000000,
OPTION=NONE DESCRIPT=’NONE’ THICKNES=100.000000000000,
PRINT=DEFAULT SAVE=DEFAULT TBIRTH=0.00000000000000,
TDEATH=0.00000000000000 TMC-MATE=1

*
SUBDIVIDE SURFACE NAME=1 MODE=LENGTH SIZE=200.000000000000
@CLEAR
1
2
3
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4
@
*
GSURFACE NODES=9 PATTERN=AUTOMATIC NCOINCID=BOUNDARIES NCEDGE=1234,

NCVERTEX=1234 NCTOLERA=1.00000000000000E-05 SUBSTRUC=0 GROUP=1,
PREFSHAP=AUTOMATIC MESHING=MAPPED SMOOTHIN=NO DEGENERA=NO,
COLLAPSE=NO MIDNODES=CURVED METHOD=ADVFRONT FLIP=NO

@CLEAR
1
2
3
4
@

DISP MAG 32.93

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

EFFECTIVE
STRESS

RST CALC

TIME 1.000

315.0
292.5
270.0
247.5
225.0
202.5
180.0
157.5
135.0
112.5
90.0
67.5
45.0
22.5
 0.0

MAXIMUM
307.3

EG 1, EL 25, IPT 11 (235.4)

MINIMUM
0.005188

EG 1, EL 88, IPT 11 (0.05509)

6.4. ábra. ”C” állvány redukált feszültség eloszlása



7. rész

Śıkbeli tartószerkezet II.

Adott a következő ”C” -állvány feladat:
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0.
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7.1. ábra. ”C” állvány

Az állvány anyaga általános acél (Linear-Elastic, Isotropic).

E = 110 GPa ν = 0.2

Az állványzat állandó vastagsága:

b = 100 mm.

A megoszló terhelés intenzitása a jelzett vonalon:

p = 10
N

mm
.

Határozzuk meg a fenti ábrán jelzett peremfeltételek mellett a ”C” állvány veszélyes
helyét (helyeit), továbbá azon helyeken a maximális feszültségek értékét!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából:
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P1 P2 P3

P4P5

P6 P7

P8 P9

P10P11P12P13

P14P15

P16 P17

P18

P19 P20

P21P22 P23

B B

S1

S2

S3

S4

S5

S6

S7

S8

S9

B B B B B BB B B B B B B B B B B B B B BB B B B B B B B B B

U
2

U
3 1

B - -

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

7.2. ábra. ”C” állvány VEM modellje
AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak y, z irányú elmozdulás és x irányú forgás van

Geometry → Coordinate System...

Add... Type: Cylindrical, Origin (0,2500,1600)

→ Points... 1: 0,0,0; 2: 0,1000,0; 3: 0,3000,0; 4: 0,3000,800; 5: 0,1000,800;
6: 0,1000,1000; 7: 0,2000,1000; 8: 0,2000,1200; 9: 0,3000,1200; 10:
0,3000,2000; 11: 0,2000,2000; 12: 0,1000,2000; 13: 0,0,2000; 14: 200,45,0,
HKR(1);15: 200,135,0, HKR(1); 16: 200,225,0, HKR(1);17: 200,315,0,HRK(1);
18: 0,2500,1600;19: 0,1000,1200;20: 0,1800,1200; 21: 0,1800,1800;22:
0,1000,1800;23: 0,2000,1800;

→ Lines → Define...

Add... Arc 1: P1=14, P2=15, Center=18 Save

Add... Arc 1: P1=15, P2=16, Center=18 Save

Add... Arc 1: P1=16, P2=17, Center=18 Save

Add... Arc 1: P1=17, P2=14, Center=18 Save

→ Surfaces → Define...

Add... Vertex 1: P1, P2, P12, P13 Save

Add... Vertex 2: P2, P3, P4, P5 Save

Add... Vertex 3: P6, P7, P8, P19 Save

Add... Vertex 4: P8, P9, P17, P16 Save

Add... Vertex 5: P9, P10, P14, P17 Save

Add... Vertex 6: P10, P11, P15, P14 Save

Add... Vertex 7: P11, P8, P16, P15 Save

Add... Vertex 8: P11, P12, P22, P23 Save

Add... Vertex 9: P20, P8, P23, P21 Save

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 110e3; Poisson’s Ratio: 0.2

→ Boundary Conditions → Define Fixity...

Add... 1: NO-YZ-TRANS y, z translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

Lines# 5: NO-YZ-TRANS

Lines# 9: NO-YZ-TRANS

→ Loading → Apply...

Define (No.1), Magnitude: 10, Pressure
Line, Site#: 17
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Meshing → Element Groups...

Add... (No.1); Type: 2D-Solid, Element Sub-Type: Plane Stress, Defa-

ult Element Thickness: 100

→ Mesh Density → Surface

Method: Use Length, Element Edge Length: 200

Surface: 1,2,3,4,5,6,7,8,9

→ Create Mesh → Surface...

2-D Solid, Element Group - No.1 Surface#: 1 2 3 4 5 6 7 8 9

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Displacement, Stress, stb.

→ Animate

DISP MAG 32.93

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

DISPLACEMENT
MAGNITUDE

TIME 1.000

15.00
14.00
13.00
12.00
11.00
10.00
9.00
8.00
7.00
6.00
5.00
4.00
3.00
2.00
1.00

MAXIMUM
15.64

NODE 493

MINIMUM
0.000

NODE 67

7.3. ábra. ”C” állvány abs. elmozdulás
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DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
FEPROGRAM PROGRAM=ADINA
*
HEADING STRING=’Gyak 06b - Plane stress SF’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=100011 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
SYSTEM NAME=1 TYPE=CYLINDRICAL MODE=1 XORIGIN=0.00000000000000,

YORIGIN=2500.00000000000 ZORIGIN=1600.00000000000,
AX=1.00000000000000 AY=0.00000000000000 AZ=0.00000000000000,
BX=0.00000000000000 BY=1.00000000000000 BZ=0.00000000000000,
MOVE=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 1000.00000000000 0.00000000000000 0
3 0.00000000000000 3000.00000000000 0.00000000000000 0
4 0.00000000000000 3000.00000000000 800.000000000000 0
5 0.00000000000000 1000.00000000000 800.000000000000 0
6 0.00000000000000 1000.00000000000 1000.00000000000 0
7 0.00000000000000 2000.00000000000 1000.00000000000 0
8 0.00000000000000 2000.00000000000 1200.00000000000 0
9 0.00000000000000 3000.00000000000 1200.00000000000 0
10 0.00000000000000 3000.00000000000 2000.00000000000 0
11 0.00000000000000 2000.00000000000 2000.00000000000 0
12 0.00000000000000 1000.00000000000 2000.00000000000 0
13 0.00000000000000 0.00000000000000 2000.00000000000 0
14 200.000000000000 45.0000000000000 0.00000000000000 1
15 200.000000000000 135.000000000000 0.00000000000000 1
16 200.000000000000 225.000000000000 0.00000000000000 1
17 200.000000000000 315.000000000000 0.00000000000000 1
18 0.00000000000000 2500.00000000000 1600.00000000000 0
19 0.00000000000000 1000.00000000000 1200.00000000000 0
20 0.00000000000000 1800.00000000000 1200.00000000000 0
21 0.00000000000000 1800.00000000000 1800.00000000000 0
22 0.00000000000000 1000.00000000000 1800.00000000000 0
23 0.00000000000000 2000.00000000000 1800.00000000000 0
@
*
LINE ARC NAME=1 MODE=1 P1=14 P2=15 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=2 MODE=1 P1=15 P2=16 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=3 MODE=1 P1=16 P2=17 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=4 MODE=1 P1=17 P2=14 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
SURFACE VERTEX NAME=1 P1=1 P2=2 P3=12 P4=13
*
SURFACE VERTEX NAME=2 P1=2 P2=3 P3=4 P4=5
*
SURFACE VERTEX NAME=3 P1=6 P2=7 P3=8 P4=19
*
SURFACE VERTEX NAME=4 P1=8 P2=9 P3=17 P4=16
*
SURFACE VERTEX NAME=5 P1=9 P2=10 P3=14 P4=17
*
SURFACE VERTEX NAME=6 P1=10 P2=11 P3=15 P4=14
*
SURFACE VERTEX NAME=7 P1=11 P2=8 P3=16 P4=15
*
SURFACE VERTEX NAME=8 P1=11 P2=12 P3=22 P4=23
*
SURFACE VERTEX NAME=9 P1=20 P2=8 P3=23 P4=21
*
MATERIAL ELASTIC NAME=1 E=110000.000000000 NU=0.200000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
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FIXITY NAME=YZ-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Z-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
@
*
FIXBOUNDARY LINES FIXITY=ALL
@CLEAR
5 ’YZ-TRANS’
9 ’YZ-TRANS’
@
*
LOAD PRESSURE NAME=1 MAGNITUD=10.0000000000000 BETA=0.00000000000000,

LINE=0
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’LINE’ 17 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TWODSOLID NAME=1 SUBTYPE=STRESS2 DISPLACE=DEFAULT,

STRAINS=DEFAULT MATERIAL=1 INT=DEFAULT RESULTS=STRESSES,
DEGEN=YES FORMULAT=0 STRESSRE=GLOBAL INITIALS=NONE FRACTUR=NO,
CMASS=DEFAULT STRAIN-F=0 UL-FORMU=DEFAULT PNTGPS=0 NODGPS=0,
LVUS1=0 LVUS2=0 SED=NO RUPTURE=ADINA INCOMPAT=DEFAULT,
TIME-OFF=0.00000000000000 POROUS=NO WTMC=1.00000000000000,
OPTION=NONE DESCRIPT=’NONE’ THICKNES=100.000000000000,
PRINT=DEFAULT SAVE=DEFAULT TBIRTH=0.00000000000000,
TDEATH=0.00000000000000 TMC-MATE=1

*
SUBDIVIDE SURFACE NAME=1 MODE=LENGTH SIZE=200.000000000000
@CLEAR
1
2
3
4
5
6
7
8
9
@
*
GSURFACE NODES=9 PATTERN=AUTOMATIC NCOINCID=BOUNDARIES NCEDGE=1234,

NCVERTEX=1234 NCTOLERA=1.00000000000000E-05 SUBSTRUC=0 GROUP=1,
PREFSHAP=AUTOMATIC MESHING=MAPPED SMOOTHIN=NO DEGENERA=NO,
COLLAPSE=NO MIDNODES=CURVED METHOD=ADVFRONT FLIP=NO

@CLEAR
1
2
3
4
5
6
7
8
9
@
*
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DISP MAG 32.93

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

EFFECTIVE
STRESS

RST CALC

TIME 1.000

466.7
433.3
400.0
366.7
333.3
300.0
266.7
233.3
200.0
166.7
133.3
100.0
66.7
33.3
 0.0

MAXIMUM
460.1

EG 1, EL 91, IPT 33 (345.6)

MINIMUM
0.005709

EG 1, EL 88, IPT 11 (0.05531)

7.4. ábra. ”C” állvány redukált feszültség eloszlása



8. rész

Śıkbeli tartószerkezet III.

Adott a következő śıkalakváltozási feladat:

90

90

z

y

p

p

p

p

50

8.1. ábra. Belső nyomással terhelt csőszerkezet

Anyaga általános acél (Linear-Elastic, Isotropic):

E = 80 GPa ν = 0.25.

Belső nyomással terhelt:

p = 10
N

mm
.

Határozzuk meg a csőszerkezet elmozdulásait, és a redukált feszültség eloszlását!

P1 P2

P3P4

P5

P6

P7

L1

L2

L3B

L4

L5

L6

L7C

B B B B BB B B B

C

C

C

C

C

C

C

C

C

U
2

U
3 1

B -
C -X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

8.2. ábra. A csőszerkezet VEM modellje

62
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A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából:

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak y, z irányú elmozdulás és x irányú forgás van

Geometry → Coordinate System...

Add... Type: Cylindrical, Origin (0,0,0)

→ Points... 1: 0,0,0; 2: 0,45,0; 3: 0,45,45; 4: 0,0,45; 5: 25,0,0 HKR(1); 6:
25,45,0 HKR(1); 7: 25,90,0 HKR(1);

→ Lines → Define...

Add... Arc 1: P1=5, P2=6, Center=1 Save

Add... Arc 1: P1=6, P2=7, Center=1 Save

→ Surfaces → Define...

Add... Vertex 1: P5, P2, P3, P6 Save

Add... Vertex 2: P3, P4, P7, P6 Save

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 80e3; Poisson’s Ratio: 0.25

→ Boundary Conditions → Define Fixity...

Add... 1: NO-Y-TRANS y translation-t bejelölni
Add... 1: NO-Z-TRANS z translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

Lines# 3: NO-Z-TRANS

Lines# 7: NO-Y-TRANS

→ Loading → Apply...

Define (No.1), Magnitude: -10, Pressure
Line, Site#: 1 Line, Site#: 2

Meshing → Element Groups...

Add... (No.1); Type: 2D-Solid, Element Sub-Type: Plane Strain

→ Mesh Density → Surface

Method: Use Length, Element Edge Length: 5

Surface: 1,2

→ Create Mesh → Surface...

2-D Solid, Element Group - No.1 Surface#: 1 2

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Displacement, Stress, stb.

→ Animate
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X Y

Z

DISPLACEMENT
MAGNITUDE

TIME 1.000

0.006600
0.006400
0.006200
0.006000
0.005800
0.005600
0.005400
0.005200
0.005000
0.004800
0.004600
0.004400
0.004200
0.004000
0.003800

MAXIMUM
0.006504

NODE 198

MINIMUM
0.003834

NODE 67

8.3. ábra. Csőszerkezet abs. elmozdulásai

X Y

Z

EFFECTIVE
STRESS

RST CALC

TIME 1.000

25.20
23.40
21.60
19.80
18.00
16.20
14.40
12.60
10.80
9.00
7.20
5.40
3.60
1.80
0.00

MAXIMUM
26.19

EG 1, EL 71, IPT 31 (25.01)

MINIMUM
0.01771

EG 1, EL 56, IPT 33 (0.02369)

8.4. ábra. Redukált feszültség eloszlása a csőszerkezetben
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DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak-07a Plane strain (SA) simple geometry’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=100011 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
SYSTEM NAME=1 TYPE=CYLINDRICAL MODE=1 XORIGIN=0.00000000000000,

YORIGIN=0.00000000000000 ZORIGIN=0.00000000000000,
AX=1.00000000000000 AY=0.00000000000000 AZ=0.00000000000000,
BX=0.00000000000000 BY=1.00000000000000 BZ=0.00000000000000,
MOVE=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 45.0000000000000 0.00000000000000 0
3 0.00000000000000 45.0000000000000 45.0000000000000 0
4 0.00000000000000 0.00000000000000 45.0000000000000 0
5 25.0000000000000 0.00000000000000 0.00000000000000 1
6 25.0000000000000 45.0000000000000 0.00000000000000 1
7 25.0000000000000 90.0000000000000 0.00000000000000 1
@
*
LINE ARC NAME=1 MODE=1 P1=5 P2=6 CENTER=1 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=2 MODE=1 P1=6 P2=7 CENTER=1 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
SURFACE VERTEX NAME=1 P1=5 P2=2 P3=3 P4=6
*
SURFACE VERTEX NAME=2 P1=3 P2=4 P3=7 P4=6
*
MATERIAL ELASTIC NAME=1 E=80000.0000000000 NU=0.250000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
FIXITY NAME=Y-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
@
*
FIXITY NAME=Z-TRANS
@CLEAR
’X-TRANSLATION’
’Z-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
@
*
FIXBOUNDARY LINES FIXITY=ALL
@CLEAR
3 ’Z-TRANS’
7 ’Y-TRANS’
@
*
LOAD PRESSURE NAME=1 MAGNITUD=-10.0000000000000 BETA=0.00000000000000,

LINE=0
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’LINE’ 1 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
2 ’PRESSURE’ 1 ’LINE’ 2 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’LINE’ 1 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,



66 8. RÉSZ: Śıkbeli tartószerkezet III.

0.00000000000000 0.00000000000000 1 0
2 ’PRESSURE’ 1 ’LINE’ 2 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TWODSOLID NAME=1 SUBTYPE=STRAIN DISPLACE=DEFAULT,

STRAINS=DEFAULT MATERIAL=1 INT=DEFAULT RESULTS=STRESSES,
DEGEN=YES FORMULAT=0 STRESSRE=GLOBAL INITIALS=NONE FRACTUR=NO,
CMASS=DEFAULT STRAIN-F=0 UL-FORMU=DEFAULT PNTGPS=0 NODGPS=0,
LVUS1=0 LVUS2=0 SED=NO RUPTURE=ADINA INCOMPAT=DEFAULT,
TIME-OFF=0.00000000000000 POROUS=NO WTMC=1.00000000000000,
OPTION=NONE DESCRIPT=’NONE’ THICKNES=1.00000000000000,
PRINT=DEFAULT SAVE=DEFAULT TBIRTH=0.00000000000000,
TDEATH=0.00000000000000 TMC-MATE=1

*
SUBDIVIDE SURFACE NAME=1 MODE=LENGTH SIZE=5.00000000000000
@CLEAR
1
2
@
*
GSURFACE NODES=9 PATTERN=AUTOMATIC NCOINCID=BOUNDARIES NCEDGE=1234,

NCVERTEX=1234 NCTOLERA=1.00000000000000E-05 SUBSTRUC=0 GROUP=1,
PREFSHAP=AUTOMATIC MESHING=MAPPED SMOOTHIN=NO DEGENERA=NO,
COLLAPSE=NO MIDNODES=CURVED METHOD=ADVFRONT FLIP=NO

@CLEAR
1
2
@
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Śıkbeli tartószerkezet IV.

Adott a következő śıkalakváltozási feladat:

90
160

40 40

z

y

p

p

p

p

50

p

p

p

p

50

9.1. ábra. Belső nyomással terhelt csőszerkezet

Anyaga általános acél (Linear-Elastic, Isotropic):

E = 80 GPa ν = 0.25.

Belső nyomással terhelt a csövezetékekben: p = 10 N
mm .

Határozzuk meg a csőszerkezet elmozdulásait, és a redukált feszültség eloszlását!

P1

P2P3

P4 P5C P6 P7

P8B

P9P10P11CP12P13

P14B P15 P16 P17D P18 P19

P20

P21

P22

P23

P24P25

P26 P27

P28P29

P30 P31

C

D

C

B B

U
2

U
3 1

B -
C -
D - - -

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

9.2. ábra. A csőszerkezet VEM modellje

67
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A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából. BŐVEBBEN LÁSD az input file-t!

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak y, z irányú elmozdulás és x irányú forgás van

Geometry → Coordinate System...

...

→ Points...

...

→ Lines → Define...

...

→ Surfaces → Define...

...

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 80e3; Poisson’s Ratio: 0.25

→ Boundary Conditions → Define Fixity...

Add... 1: NO-Y-TRANS y translation-t bejelölni
Add... 1: NO-Z-TRANS z translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

...

→ Loading → Apply...

Define (No.1), Magnitude: -10, Pressure
...

Meshing → Element Groups...

Add... (No.1); Type: 2D-Solid, Element Sub-Type: Plane Strain

→ Mesh Density → Surface

Method: Use Length, Element Edge Length: 10

Surface: 1,2,...

→ Create Mesh → Surface...

2-D Solid, Element Group - No.1 Surface#: 1,2,...

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Displacement, Stress, stb.

→ Animate
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X Y

Z

DISPLACEMENT
MAGNITUDE

TIME 1.000

0.01120
0.01040
0.00960
0.00880
0.00800
0.00720
0.00640
0.00560
0.00480
0.00400
0.00320
0.00240
0.00160
0.00080
0.00000

MAXIMUM
0.01123

NODE 519

MINIMUM
5.421E-20

NODE 102 (0.000)

9.3. ábra. Csőszerkezet abs. elmozdulásai

X Y

Z

EFFECTIVE
STRESS

RST CALC

TIME 1.000

28.00
26.00
24.00
22.00
20.00
18.00
16.00
14.00
12.00
10.00
8.00
6.00
4.00
2.00
0.00

MAXIMUM
29.53

EG 1, EL 136, IPT 11 (27.11)

MINIMUM
0.01376

EG 1, EL 117, IPT 31 (0.6111)

9.4. ábra. Redukált feszültség eloszlása a csőszerkezetben



70 9. RÉSZ: Śıkbeli tartószerkezet IV.

DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak 07b - Plane Strain Problem (SA)’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=100011 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
SYSTEM NAME=1 TYPE=CYLINDRICAL MODE=1 XORIGIN=0.00000000000000,

YORIGIN=120.000000000000 ZORIGIN=45.0000000000000,
AX=1.00000000000000 AY=0.00000000000000 AZ=0.00000000000000,
BX=0.00000000000000 BY=1.00000000000000 BZ=0.00000000000000,
MOVE=NO

*
*
SYSTEM NAME=2 TYPE=CYLINDRICAL MODE=1 XORIGIN=0.00000000000000,

YORIGIN=40.0000000000000 ZORIGIN=45.0000000000000,
AX=1.00000000000000 AY=0.00000000000000 AZ=0.00000000000000,
BX=0.00000000000000 BY=1.00000000000000 BZ=0.00000000000000,
MOVE=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 120.000000000000 45.0000000000000 0
3 0.00000000000000 40.0000000000000 45.0000000000000 0
4 0.00000000000000 40.0000000000000 0.00000000000000 0
5 0.00000000000000 80.0000000000000 0.00000000000000 0
6 0.00000000000000 120.000000000000 0.00000000000000 0
7 0.00000000000000 160.000000000000 0.00000000000000 0
8 0.00000000000000 160.000000000000 45.0000000000000 0
9 0.00000000000000 160.000000000000 90.0000000000000 0
10 0.00000000000000 120.000000000000 90.0000000000000 0
11 0.00000000000000 80.0000000000000 90.0000000000000 0
12 0.00000000000000 40.0000000000000 90.0000000000000 0
13 0.00000000000000 0.00000000000000 90.0000000000000 0
14 0.00000000000000 0.00000000000000 45.0000000000000 0
15 0.00000000000000 15.0000000000000 45.0000000000000 0
16 0.00000000000000 65.0000000000000 45.0000000000000 0
17 0.00000000000000 80.0000000000000 45.0000000000000 0
18 0.00000000000000 95.0000000000000 45.0000000000000 0
19 0.00000000000000 145.000000000000 45.0000000000000 0
20 0.00000000000000 40.0000000000000 20.0000000000000 0
21 0.00000000000000 40.0000000000000 70.0000000000000 0
22 0.00000000000000 120.000000000000 20.0000000000000 0
23 0.00000000000000 120.000000000000 70.0000000000000 0
24 25.0000000000000 45.0000000000000 0.00000000000000 1
25 25.0000000000000 135.000000000000 0.00000000000000 1
26 25.0000000000000 225.000000000000 0.00000000000000 1
27 25.0000000000000 315.000000000000 0.00000000000000 1
28 25.0000000000000 45.0000000000000 0.00000000000000 2
29 25.0000000000000 135.000000000000 0.00000000000000 2
30 25.0000000000000 225.000000000000 0.00000000000000 2
31 25.0000000000000 315.000000000000 0.00000000000000 2
@
*
LINE ARC NAME=1 MODE=1 P1=16 P2=28 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=2 MODE=1 P1=28 P2=21 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=3 MODE=1 P1=21 P2=29 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=4 MODE=1 P1=29 P2=15 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=5 MODE=1 P1=15 P2=30 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=6 MODE=1 P1=30 P2=20 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=7 MODE=1 P1=20 P2=31 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
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*
LINE ARC NAME=8 MODE=1 P1=31 P2=16 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=9 MODE=1 P1=19 P2=24 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=10 MODE=1 P1=24 P2=23 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=11 MODE=1 P1=23 P2=25 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=12 MODE=1 P1=25 P2=18 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=13 MODE=1 P1=18 P2=26 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=14 MODE=1 P1=26 P2=22 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=15 MODE=1 P1=22 P2=27 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=16 MODE=1 P1=27 P2=19 CENTER=2 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
SURFACE VERTEX NAME=1 P1=1 P2=4 P3=20 P4=30
*
SURFACE VERTEX NAME=2 P1=4 P2=5 P3=31 P4=20
*
SURFACE VERTEX NAME=3 P1=5 P2=17 P3=16 P4=31
*
SURFACE VERTEX NAME=4 P1=17 P2=11 P3=28 P4=16
*
SURFACE VERTEX NAME=5 P1=11 P2=12 P3=21 P4=28
*
SURFACE VERTEX NAME=6 P1=12 P2=13 P3=29 P4=21
*
SURFACE VERTEX NAME=7 P1=13 P2=14 P3=15 P4=29
*
SURFACE VERTEX NAME=8 P1=14 P2=1 P3=30 P4=15
*
SURFACE VERTEX NAME=9 P1=5 P2=6 P3=22 P4=26
*
SURFACE VERTEX NAME=10 P1=6 P2=7 P3=27 P4=22
*
SURFACE VERTEX NAME=11 P1=7 P2=8 P3=19 P4=27
*
SURFACE VERTEX NAME=12 P1=8 P2=9 P3=24 P4=19
*
SURFACE VERTEX NAME=13 P1=9 P2=10 P3=23 P4=24
*
SURFACE VERTEX NAME=14 P1=10 P2=11 P3=25 P4=23
*
SURFACE VERTEX NAME=15 P1=11 P2=17 P3=18 P4=25
*
SURFACE VERTEX NAME=16 P1=17 P2=5 P3=26 P4=18
*
MATERIAL ELASTIC NAME=1 E=80000.0000000000 NU=0.250000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
FIXITY NAME=Y-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
@
*
FIXITY NAME=Z-TRANS
@CLEAR
’X-TRANSLATION’
’Z-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
@
*
FIXBOUNDARY POINTS FIXITY=ALL
@CLEAR
5 ’Y-TRANS’
8 ’Z-TRANS’
11 ’Y-TRANS’
14 ’Z-TRANS’
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17 ’ALL’
@
LOAD PRESSURE NAME=1 MAGNITUD=-10.0000000000000 BETA=0.00000000000000,

LINE=0
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’LINE’ 1 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
2 ’PRESSURE’ 1 ’LINE’ 2 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
3 ’PRESSURE’ 1 ’LINE’ 3 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
4 ’PRESSURE’ 1 ’LINE’ 4 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
5 ’PRESSURE’ 1 ’LINE’ 5 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
6 ’PRESSURE’ 1 ’LINE’ 6 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
7 ’PRESSURE’ 1 ’LINE’ 7 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
8 ’PRESSURE’ 1 ’LINE’ 8 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
9 ’PRESSURE’ 1 ’LINE’ 9 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
10 ’PRESSURE’ 1 ’LINE’ 10 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
11 ’PRESSURE’ 1 ’LINE’ 11 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
12 ’PRESSURE’ 1 ’LINE’ 12 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
13 ’PRESSURE’ 1 ’LINE’ 13 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
14 ’PRESSURE’ 1 ’LINE’ 14 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
15 ’PRESSURE’ 1 ’LINE’ 15 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
16 ’PRESSURE’ 1 ’LINE’ 16 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TWODSOLID NAME=1 SUBTYPE=STRAIN DISPLACE=DEFAULT,

STRAINS=DEFAULT MATERIAL=1 INT=DEFAULT RESULTS=STRESSES,
DEGEN=YES FORMULAT=0 STRESSRE=GLOBAL INITIALS=NONE FRACTUR=NO,
CMASS=DEFAULT STRAIN-F=0 UL-FORMU=DEFAULT PNTGPS=0 NODGPS=0,
LVUS1=0 LVUS2=0 SED=NO RUPTURE=ADINA INCOMPAT=DEFAULT,
TIME-OFF=0.00000000000000 POROUS=NO WTMC=1.00000000000000,
OPTION=NONE DESCRIPT=’NONE’ THICKNES=1.00000000000000,
PRINT=DEFAULT SAVE=DEFAULT TBIRTH=0.00000000000000,
TDEATH=0.00000000000000 TMC-MATE=1

*
SUBDIVIDE SURFACE NAME=1 MODE=LENGTH SIZE=10.0000000000000
@CLEAR
1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
@
*
GSURFACE NODES=9 PATTERN=AUTOMATIC NCOINCID=BOUNDARIES NCEDGE=1234,

NCVERTEX=1234 NCTOLERA=1.00000000000000E-05 SUBSTRUC=0 GROUP=1,
PREFSHAP=AUTOMATIC MESHING=MAPPED SMOOTHIN=NO DEGENERA=NO,
COLLAPSE=NO MIDNODES=CURVED METHOD=ADVFRONT FLIP=NO

@CLEAR
1
2
3
4
5
6
7
8
9
10
11
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12
13
14
15
16
@
*



10. rész

Śıkbeli tartószerkezet V.

Adott a következő feladat:

y

z

60

60

R20
R30

45◦

p2

p1

10
0

b = 5

10.1. ábra. Fogasszerű szerkezet

Anyaga általános acél (Linear-Elastic, Isotropic):

E = 150 GPa ν = 0.2.

A két terhelési érték:
p1 = 3, 98

N
mm

p2 = 5
N

mm
Határozzuk meg a szerkezet elmozdulásait, és a redukált feszültség eloszlását!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából. BŐVEBBEN LÁSD az input file-t!
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AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak y, z irányú elmozdulás és x irányú forgás van

Geometry → Coordinate System...

...

→ Points...

...

→ Lines → Define...

...

→ Surfaces → Define...

...

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 150e3; Poisson’s Ratio: 0.2

→ Boundary Conditions → Define Fixity...

Add... 1: NO-Y-TRANS y translation-t bejelölni
Add... 1: NO-Z-TRANS z translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

...

→ Loading → Apply...

Define (No.1)

Define (No.2)

...

Meshing → Element Groups...

Add... (No.1); Type: 2D-Solid, Element Sub-Type: Plane Stress

Default Element Thickness: 5mm

→ Mesh Density → Surface

Method: Use Length, Element Edge Length: 10

Surface: 1,2,...

→ Create Mesh → Surface...

2-D Solid, Element Group - No.1 Surface#: 1,2,...

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Displacement, Stress, stb.

→ Animate
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P1B P2 P3 P4 P5

P6C P7

P8P9

P10

P11
S1 S2

S3

S4

B

C

U
2

U
3 1

B -
C - -

TIME 1.000

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

5.000

10.2. ábra. A fogas VEM modellje

DISP MAG 8.686

X Y

Z

DISPLACEMENT
MAGNITUDE

TIME 1.000

2.240
2.080
1.920
1.760
1.600
1.440
1.280
1.120
0.960
0.800
0.640
0.480
0.320
0.160
0.000

MAXIMUM
2.185

NODE 400

MINIMUM
0.000

NODE 207

EFFECTIVE
STRESS

RST CALC

TIME 1.000

466.7
433.3
400.0
366.7
333.3
300.0
266.7
233.3
200.0
166.7
133.3
100.0
66.7
33.3
 0.0

MAXIMUM
443.8

EG 1, EL 72, IPT 13 (337.5)

MINIMUM
0.07389

EG 1, EL 22, IPT 31 (0.2009)

10.3. ábra. Fogasszerkezet elmozdulásai és a redukált felszültség eloszlása
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DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak - 07: Plane stress SF (fogas)’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=100011 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1,
IPOSIT=STOP REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT,
CMASS=NO SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 10.0000000000000 0.00000000000000 0
3 0.00000000000000 30.0000000000000 0.00000000000000 0
4 0.00000000000000 50.0000000000000 0.00000000000000 0
5 0.00000000000000 60.0000000000000 0.00000000000000 0
6 0.00000000000000 0.00000000000000 100.000000000000 0
7 0.00000000000000 10.0000000000000 100.000000000000 0
8 0.00000000000000 70.0000000000000 160.000000000000 0
9 0.00000000000000 60.0000000000000 160.000000000000 0
10 0.00000000000000 30.0000000000000 -30.0000000000000 0
11 0.00000000000000 30.0000000000000 -20.0000000000000 0
@
*
LINE ARC NAME=1 MODE=1 P1=1 P2=10 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=2 MODE=1 P1=10 P2=5 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=3 MODE=1 P1=2 P2=11 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=4 MODE=1 P1=11 P2=4 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
SURFACE VERTEX NAME=1 P1=1 P2=2 P3=11 P4=10
*
SURFACE VERTEX NAME=2 P1=4 P2=5 P3=11 P4=10
*
SURFACE VERTEX NAME=2 P1=4 P2=5 P3=10 P4=11
*
DELETE SURFACE FIRST=2 LAST=2 OPTION=SURFACE
*
DELETE LINE ALL FIRST=9 LAST=9
*
DELETE LINE ALL FIRST=8 LAST=8
*
DELETE LINE ALL FIRST=7 LAST=7
*
SURFACE VERTEX NAME=2 P1=4 P2=5 P3=10 P4=11
*
SURFACE VERTEX NAME=3 P1=1 P2=2 P3=7 P4=6
*
SURFACE VERTEX NAME=4 P1=6 P2=7 P3=8 P4=9
*
MATERIAL ELASTIC NAME=1 E=150000.000000000 NU=0.200000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
FIXITY NAME=YZ-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Z-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
@
*
FIXITY NAME=Y-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Y-ROTATION’
’Z-ROTATION’
’OVALIZATION’
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@
*
FIXBOUNDARY POINTS FIXITY=ALL
@CLEAR
1 ’Y-TRANS’
6 ’YZ-TRANS’
@
*
LOAD PRESSURE NAME=1 MAGNITUD=-3.98000000000000 BETA=0.00000000000000,

LINE=0
*
LOAD PRESSURE NAME=2 MAGNITUD=5.00000000000000 BETA=0.00000000000000,

LINE=0
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’LINE’ 3 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
2 ’PRESSURE’ 1 ’LINE’ 4 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
3 ’PRESSURE’ 2 ’LINE’ 12 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP TWODSOLID NAME=1 SUBTYPE=STRESS2 DISPLACE=DEFAULT,

STRAINS=DEFAULT MATERIAL=1 INT=DEFAULT RESULTS=STRESSES,
DEGEN=YES FORMULAT=0 STRESSRE=GLOBAL INITIALS=NONE FRACTUR=NO,
CMASS=DEFAULT STRAIN-F=0 UL-FORMU=DEFAULT PNTGPS=0 NODGPS=0,
LVUS1=0 LVUS2=0 SED=NO RUPTURE=ADINA INCOMPAT=DEFAULT,
TIME-OFF=0.00000000000000 POROUS=NO WTMC=1.00000000000000,
OPTION=NONE DESCRIPT=’NONE’ THICKNES=5.00000000000000,
PRINT=DEFAULT SAVE=DEFAULT TBIRTH=0.00000000000000,
TDEATH=0.00000000000000 TMC-MATE=1

*
SUBDIVIDE SURFACE NAME=1 MODE=LENGTH SIZE=5.00000000000000
@CLEAR
1
2
3
4
@
*
GSURFACE NODES=9 PATTERN=AUTOMATIC NCOINCID=BOUNDARIES NCEDGE=1234,

NCVERTEX=1234 NCTOLERA=1.00000000000000E-05 SUBSTRUC=0 GROUP=1,
PREFSHAP=AUTOMATIC MESHING=MAPPED SMOOTHIN=NO DEGENERA=NO,
COLLAPSE=NO MIDNODES=CURVED METHOD=ADVFRONT FLIP=NO

@CLEAR
1
2
3
4
@



11. rész

Térbeli tartószerkezet I.

Adott a következő ”C” -állvány feladat:

z

y

3 m

1 m

1 m2

m

b

0.
2

m

0.
4

m

0.4 m

0.5 m

0.
8

m
0.

2

m

0.
8

m

p

0.6 m

0.
6

m

11.1. ábra. ”C” állvány

Az állvány anyaga általános acél (Linear-Elastic, Isotropic).

E = 110 GPa ν = 0.2

Az állványzat állandó vastagsága:

b = 100 mm.

A megoszló terhelés intenzitása a jelzett vonalon:

p = 10
N

mm
.

Határozzuk meg a fenti ábrán jelzett peremfeltételek mellett a ”C” állvány veszélyes
helyét (helyeit), továbbá azon helyeken a maximális feszültségek értékét!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából (a 2D-s feladat plussz a megfelelő Extrude parancs lásd a
csatolt input file-t!
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B
B

B
B

B
B

B
B

B
B

B

BB
B

B
B

B
B

B
B

B
B

B
B

B
B

B
B

B
B

B
B

B

U
1

U
2

U
3 1 2 3

B - - - - - -

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

11.2. ábra. ”C” állvány 3D-s VEM modellje (27-nodes elemekkel)

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak y, z irányú elmozdulás és x irányú forgás van

Geometry → Coordinate System...

Add... Type: Cylindrical, Origin (0,2500,1600)

→ Points... 1: 0,0,0; 2: 0,1000,0; 3: 0,3000,0; 4: 0,3000,800; 5: 0,1000,800;
6: 0,1000,1000; 7: 0,2000,1000; 8: 0,2000,1200; 9: 0,3000,1200; 10:
0,3000,2000; 11: 0,2000,2000; 12: 0,1000,2000; 13: 0,0,2000; 14: 200,45,0,
HKR(1);15: 200,135,0, HKR(1); 16: 200,225,0, HKR(1);17: 200,315,0,HRK(1);
18: 0,2500,1600;19: 0,1000,1200;20: 0,1800,1200; 21: 0,1800,1800;22:
0,1000,1800;23: 0,2000,1800;

→ Lines → Define...

Add... Arc 1: P1=14, P2=15, Center=18 Save

Add... Arc 1: P1=15, P2=16, Center=18 Save

Add... Arc 1: P1=16, P2=17, Center=18 Save

Add... Arc 1: P1=17, P2=14, Center=18 Save

→ Surfaces → Define...

Add... Vertex 1: P1, P2, P12, P13 Save

Add... Vertex 2: P2, P3, P4, P5 Save

Add... Vertex 3: P6, P7, P8, P19 Save

Add... Vertex 4: P8, P9, P17, P16 Save

Add... Vertex 5: P9, P10, P14, P17 Save

Add... Vertex 6: P10, P11, P15, P14 Save

Add... Vertex 7: P11, P8, P16, P15 Save

Add... Vertex 8: P11, P12, P22, P23 Save

Add... Vertex 9: P20, P8, P23, P21 Save

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 110e3; Poisson’s Ratio: 0.2

→ Boundary Conditions → Define Fixity...

Add... 1: NO-YZ-TRANS y, z translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

Lines# 5: NO-YZ-TRANS

Lines# 9: NO-YZ-TRANS

→ Loading → Apply...

Define (No.1), Magnitude: 10, Pressure
Line, Site#: 17
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Meshing → Element Groups...

Add... (No.1); Type: 2D-Solid, Element Sub-Type: Plane Stress, Defa-

ult Element Thickness: 100

→ Mesh Density → Surface

Method: Use Length, Element Edge Length: 200

Surface: 1,2,3,4,5,6,7,8,9

→ Create Mesh → Surface...

2-D Solid, Element Group - No.1 Surface#: 1 2 3 4 5 6 7 8 9

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Displacement, Stress, stb.

→ Animate

DISP MAG 33.42

X Y

Z

DISPLACEMENT
MAGNITUDE

TIME 1.000

15.00
14.00
13.00
12.00
11.00
10.00
9.00
8.00
7.00
6.00
5.00
4.00
3.00
2.00
1.00

MAXIMUM
15.60

NODE 1524

MINIMUM
0.000

NODE 1

PRESCRIBED
PRESSURE

TIME 1.000

10.00

11.3. ábra. ”C” állvány abs. elmozdulás (27-nodes elemekkel)
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DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
FEPROGRAM PROGRAM=ADINA
*
CONTROL PLOTUNIT=PERCENT VERBOSE=YES ERRORLIM=0 LOGLIMIT=0 UNDO=5,

PROMPTDE=UNKNOWN AUTOREPA=YES DRAWMATT=YES DRAWTEXT=EXACT,
DRAWLINE=EXACT DRAWFILL=EXACT AUTOMREB=YES ZONECOPY=NO,
SWEEPCOI=YES SESSIONS=YES DYNAMICT=YES UPDATETH=YES AUTOREGE=NO,
ERRORACT=CONTINUE FILEVERS=V85 INITFCHE=NO SIGDIGIT=6,
AUTOZONE=YES PSFILEVE=V0

*
FEPROGRAM PROGRAM=ADINA
*
HEADING STRING=’Gyak 11 - 3D problem of C-allv’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000 IDOF=0,

OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1 IPOSIT=STOP,
REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT CMASS=NO,
SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
SYSTEM NAME=1 TYPE=CYLINDRICAL MODE=1 XORIGIN=0.00000000000000,

YORIGIN=2500.00000000000 ZORIGIN=1600.00000000000,
AX=1.00000000000000 AY=0.00000000000000 AZ=0.00000000000000,
BX=0.00000000000000 BY=1.00000000000000 BZ=0.00000000000000,
MOVE=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 1000.00000000000 0.00000000000000 0
3 0.00000000000000 3000.00000000000 0.00000000000000 0
4 0.00000000000000 3000.00000000000 800.000000000000 0
5 0.00000000000000 1000.00000000000 800.000000000000 0
6 0.00000000000000 1000.00000000000 1000.00000000000 0
7 0.00000000000000 2000.00000000000 1000.00000000000 0
8 0.00000000000000 2000.00000000000 1200.00000000000 0
9 0.00000000000000 3000.00000000000 1200.00000000000 0
10 0.00000000000000 3000.00000000000 2000.00000000000 0
11 0.00000000000000 2000.00000000000 2000.00000000000 0
12 0.00000000000000 1000.00000000000 2000.00000000000 0
13 0.00000000000000 0.00000000000000 2000.00000000000 0
14 200.000000000000 45.0000000000000 0.00000000000000 1
15 200.000000000000 135.000000000000 0.00000000000000 1
16 200.000000000000 225.000000000000 0.00000000000000 1
17 200.000000000000 315.000000000000 0.00000000000000 1
18 0.00000000000000 2500.00000000000 1600.00000000000 0
19 0.00000000000000 1000.00000000000 1200.00000000000 0
20 0.00000000000000 1800.00000000000 1200.00000000000 0
21 0.00000000000000 1800.00000000000 1800.00000000000 0
22 0.00000000000000 1000.00000000000 1800.00000000000 0
23 0.00000000000000 2000.00000000000 1800.00000000000 0
@
*
LINE ARC NAME=1 MODE=1 P1=14 P2=15 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=2 MODE=1 P1=15 P2=16 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=3 MODE=1 P1=16 P2=17 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=4 MODE=1 P1=17 P2=14 CENTER=18 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
SURFACE VERTEX NAME=1 P1=1 P2=2 P3=12 P4=13
*
SURFACE VERTEX NAME=2 P1=2 P2=3 P3=4 P4=5
*
SURFACE VERTEX NAME=3 P1=6 P2=7 P3=8 P4=19
*
SURFACE VERTEX NAME=4 P1=8 P2=9 P3=17 P4=16
*
SURFACE VERTEX NAME=5 P1=9 P2=10 P3=14 P4=17
*
SURFACE VERTEX NAME=6 P1=10 P2=11 P3=15 P4=14
*
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SURFACE VERTEX NAME=7 P1=11 P2=8 P3=16 P4=15
*
SURFACE VERTEX NAME=8 P1=11 P2=12 P3=22 P4=23
*
SURFACE VERTEX NAME=9 P1=20 P2=8 P3=23 P4=21
*
MATERIAL ELASTIC NAME=1 E=110000.000000000 NU=0.200000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
VOLUME EXTRUDED NAME=1 SURFACE=0 DX=100.000000000000,

DY=0.00000000000000 DZ=0.00000000000000 SYSTEM=1 PCOINCID=YES,
PTOLERAN=1.00000000000000E-05 NDIV=1 OPTION=VECTOR,
RATIO=1.00000000000000 PROGRESS=GEOMETRIC CBIAS=NO

@CLEAR
1
2
3
4
5
6
7
8
9
@
*
FIXBOUNDARY SURFACES FIXITY=ALL
@CLEAR
10 ’ALL’
15 ’ALL’
@
*
LOAD PRESSURE NAME=1 MAGNITUD=-10.0000000000000 BETA=0.00000000000000,

LINE=0
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’SURFACE’ 25 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP THREEDSOLID NAME=1 DISPLACE=DEFAULT STRAINS=DEFAULT MATERIAL=1,

RSINT=DEFAULT TINT=DEFAULT RESULTS=STRESSES DEGEN=YES FORMULAT=0,
STRESSRE=GLOBAL INITIALS=NONE FRACTUR=NO CMASS=DEFAULT,
STRAIN-F=0 UL-FORMU=DEFAULT LVUS1=0 LVUS2=0 SED=NO RUPTURE=ADINA,
INCOMPAT=DEFAULT TIME-OFF=0.00000000000000 POROUS=NO,
WTMC=1.00000000000000 OPTION=NONE DESCRIPT=’NONE’ PRINT=DEFAULT,
SAVE=DEFAULT TBIRTH=0.00000000000000 TDEATH=0.00000000000000,
TMC-MATE=1

*
SUBDIVIDE VOLUME NAME=1 MODE=LENGTH SIZE=200.000000000000
@CLEAR
1
2
3
4
5
6
7
8
9
@
*
GVOLUME NODES=27 PATTERN=0 NCOINCID=BOUNDARIES NCFACE=123456 NCEDGE=,
’123456789ABC’ NCVERTEX=12345678 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=1 MESHING=MAPPED PREFSHAP=AUTOMATIC,
DEGENERA=YES COLLAPSE=NO MIDNODES=CURVED METHOD=DELAUNAY,
BOUNDARY=ADVFRONT

@CLEAR
1
2
3
4
5
6
7
8
9
@



84 11. RÉSZ: Térbeli tartószerkezet I.

DISP MAG 33.42

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

10.00

EFFECTIVE
STRESS

RST CALC

TIME 1.000

420.0
390.0
360.0
330.0
300.0
270.0
240.0
210.0
180.0
150.0
120.0
90.0
60.0
30.0
 0.0

MAXIMUM
442.3

EG 1, EL 95, IPT 132 (335.6)

MINIMUM
0.004268

EG 1, EL 83, IPT 311 (0.05320)

11.4. ábra. ”C” állvány redukált feszültség eloszlása (27-nodes elemekkel)



12. rész

Térbeli tartószerkezet II.

Adott a következő feladat:

y

z

60

60

R20
R30

45◦

p2

p1

10
0

b = 5

12.1. ábra. Fogasszerű szerkezet

Anyaga általános acél (Linear-Elastic, Isotropic):

E = 150 GPa ν = 0.2.

A két terhelési érték:
p1 = 3, 98

N
mm

p2 = 5
N

mm
Határozzuk meg a szerkezet elmozdulásait, és a redukált feszültség eloszlását!

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából. (2D-s feladat plussz a Extrude parancs.) BŐVEBBEN
LÁSD az input file-t!
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86 12. RÉSZ: Térbeli tartószerkezet II.

AUI, ADINA Structures, Statics, No FSI

Control → Heading

→ Degrees of Freedom... csak y, z irányú elmozdulás és x irányú forgás van

Geometry → Coordinate System...

...

→ Points...

...

→ Lines → Define...

...

→ Surfaces → Define...

...

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 80e3; Poisson’s Ratio: 0.25

→ Boundary Conditions → Define Fixity...

Add... 1: NO-Y-TRANS y translation-t bejelölni
Add... 1: NO-Z-TRANS z translation-t bejelölni

→ Boundary Conditions → Apply Fixity Points

...

→ Loading → Apply...

Define (No.1), Magnitude: -10, Pressure
...

Meshing → Element Groups...

Add... (No.1); Type: 2D-Solid, Element Sub-Type: Plane Strain

→ Mesh Density → Surface

Method: Use Length, Element Edge Length: 10

Surface: 1,2,...

→ Create Mesh → Surface...

2-D Solid, Element Group - No.1 Surface#: 1,2,...

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Displacement, Stress, stb.

→ Animate
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B

C

U
1

U
2

U
3 1 2 3

B - -
C - - - - - -

X Y

Z

PRESCRIBED
PRESSURE

TIME 1.000

5.000

12.2. ábra. A fogas VEM modellje

EFFECTIVE
STRESS

RST CALC

TIME 1.000

420.0
390.0
360.0
330.0
300.0
270.0
240.0
210.0
180.0
150.0
120.0
90.0
60.0
30.0
 0.0

MAXIMUM
438.4

EG 1, EL 71, IPT 332 (335.7)

MINIMUM
0.06507

EG 1, EL 22, IPT 333 (0.2109)

DISP MAG 6.714

X Y

Z

DISPLACEMENT
MAGNITUDE

TIME 1.000

2.240
2.080
1.920
1.760
1.600
1.440
1.280
1.120
0.960
0.800
0.640
0.480
0.320
0.160
0.000

MAXIMUM
2.184

NODE 1368

MINIMUM
0.000

NODE 827

12.3. ábra. Fogasszerkezet elmozdulásai és a redukált felszültség eloszlása



88 12. RÉSZ: Térbeli tartószerkezet II.

DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
HEADING STRING=’Gyak - 12: 3D problem (fogas)’
*
MASTER ANALYSIS=STATIC MODEX=EXECUTE TSTART=0.00000000000000 IDOF=0,

OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1 IPOSIT=STOP,
REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT CMASS=NO,
SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 10.0000000000000 0.00000000000000 0
3 0.00000000000000 30.0000000000000 0.00000000000000 0
4 0.00000000000000 50.0000000000000 0.00000000000000 0
5 0.00000000000000 60.0000000000000 0.00000000000000 0
6 0.00000000000000 0.00000000000000 100.000000000000 0
7 0.00000000000000 10.0000000000000 100.000000000000 0
8 0.00000000000000 70.0000000000000 160.000000000000 0
9 0.00000000000000 60.0000000000000 160.000000000000 0
10 0.00000000000000 30.0000000000000 -30.0000000000000 0
11 0.00000000000000 30.0000000000000 -20.0000000000000 0
@
*
LINE ARC NAME=1 MODE=1 P1=1 P2=10 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=2 MODE=1 P1=10 P2=5 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=3 MODE=1 P1=2 P2=11 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
LINE ARC NAME=4 MODE=1 P1=11 P2=4 CENTER=3 PCOINCID=YES,

PTOLERAN=1.00000000000000E-05 MODIFY-L=YES DELETE-P=YES
*
SURFACE VERTEX NAME=1 P1=1 P2=2 P3=11 P4=10
*
SURFACE VERTEX NAME=2 P1=4 P2=5 P3=10 P4=11
*
SURFACE VERTEX NAME=3 P1=1 P2=2 P3=7 P4=6
*
SURFACE VERTEX NAME=4 P1=6 P2=7 P3=8 P4=9
*
SUBDIVIDE SURFACE NAME=1 MODE=LENGTH SIZE=5.00000000000000
@CLEAR
1
2
3
4
@
*
MATERIAL ELASTIC NAME=1 E=150000.000000000 NU=0.200000000000000,

DENSITY=0.00000000000000 ALPHA=0.00000000000000 MDESCRIP=’NONE’
*
VOLUME EXTRUDED NAME=1 SURFACE=0 DX=5.00000000000000,

DY=0.00000000000000 DZ=0.00000000000000 SYSTEM=0 PCOINCID=YES,
PTOLERAN=1.00000000000000E-05 NDIV=1 OPTION=VECTOR,
RATIO=1.00000000000000 PROGRESS=GEOMETRIC CBIAS=NO

@CLEAR
1
2
3
4
@
*
FIXITY NAME=XY-TRANS
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’OVALIZATION’
@
*
FIXBOUNDARY LINES FIXITY=ALL
@CLEAR
28 ’ALL’
14 ’XY-TRANS’
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@
*
LOAD PRESSURE NAME=1 MAGNITUD=3.98000000000000 BETA=0.00000000000000,

LINE=0
*
LOAD PRESSURE NAME=2 MAGNITUD=-5.00000000000000 BETA=0.00000000000000,

LINE=0
*
APPLY-LOAD BODY=0
@CLEAR
1 ’PRESSURE’ 1 ’SURFACE’ 6 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
2 ’PRESSURE’ 1 ’SURFACE’ 12 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
3 ’PRESSURE’ 2 ’SURFACE’ 19 0 1 0.00000000000000 0 -1 0 0 0 ’NO’,

0.00000000000000 0.00000000000000 1 0
@
*
EGROUP THREEDSOLID NAME=1 DISPLACE=DEFAULT STRAINS=DEFAULT MATERIAL=1,

RSINT=DEFAULT TINT=DEFAULT RESULTS=STRESSES DEGEN=YES FORMULAT=0,
STRESSRE=GLOBAL INITIALS=NONE FRACTUR=NO CMASS=DEFAULT,
STRAIN-F=0 UL-FORMU=DEFAULT LVUS1=0 LVUS2=0 SED=NO RUPTURE=ADINA,
INCOMPAT=DEFAULT TIME-OFF=0.00000000000000 POROUS=NO,
WTMC=1.00000000000000 OPTION=NONE DESCRIPT=’NONE’ PRINT=DEFAULT,
SAVE=DEFAULT TBIRTH=0.00000000000000 TDEATH=0.00000000000000,
TMC-MATE=1

*
GVOLUME NODES=27 PATTERN=0 NCOINCID=BOUNDARIES NCFACE=123456 NCEDGE=,
’123456789ABC’ NCVERTEX=12345678 NCTOLERA=1.00000000000000E-05,

SUBSTRUC=0 GROUP=1 MESHING=MAPPED PREFSHAP=AUTOMATIC,
DEGENERA=YES COLLAPSE=NO MIDNODES=CURVED METHOD=DELAUNAY,
BOUNDARY=ADVFRONT

@CLEAR
1
2
3
4
@
*



13. rész

Sajátfrekvenciák meghatározása

ADINA használata sajátfrekvenicák meghatározására

Határozzuk meg a rézből készült kürt 30 legkisebb sajátfrekvenciáját.

P3(5, 0, 50)

P4(10, 0, 100)

P4(50, 0, 200)

P2(0, 0, 300)

P1(0, 0, 0)

z

x

13.1. ábra. Kürt geometria vázlata

A fenti ábrán vázolt kürt csak egy jelleghelyes ábra, a konkrét méretezését a mellőzzük.
Anyaga réz (Linear-Elastic, Isotropic), a következő anyagjellemzőkkel:

E = 115 GPa ν = 0.36 ρ = 8900
kg
m3

= 8.9 · 10−9 tonna
mm3

A feladat végrehajtásához használandó főbb funkciók, parancsok:

A feladat végrehajtásához használandó főbb funkciók, parancsok, elérésük a meg-
adott menühierarchiából. BŐVEBBEN LÁSD az input file-t!
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AUI, ADINA Structures, Frequencies/Modes, No FSI

Module Bar Number of Frequencies/Modes Shapes: 30

Number of Mode Shapes to be Printed: 30

Solution Method: Lanczos Iteration

Control → Heading

→ Degrees of Freedom...

Geometry → Points... 1: 0,0,0; 2:0,0,300; 3: 5,0,50; 4: 10,0,100; 5: 50,0,200;

→ Lines → Define...

Add... Straight 1: P1=1, P2=2 Save

Add... Polyline, Type: Spline 3, 4, 5 Save

→ Surfaces → Define...

Add... Revolved

Angle of Rotation: 360

Line#: 2

Axis of Revolution: Line: 1 Save

Model → Materials → Elastic → Isotropic

Add... Young’s modulus: 115E3; Poisson’s Ratio: 0.3 Density: 8.9E-9

→ Boundary Conditions → Define Fixity...

Add... 1: NO-TRANSLATION X, Y, Z Translation-t bejelölni

→ Boundary Conditions → Apply Fixity Lines: 3

Meshing → Element Groups...

Add... (No.1); Type: Shell, Element Thickness: 0.2

→ Mesh Density → Line...

Method: Use Number of Divisions

Line#: 2 Number of Subdivisions: 20 Length Ratio...: 5

Line#: 3 Number of Subdivisions: 5 Length Ratio...: 1

Line#: 4 Number of Subdivisions: 20 Length Ratio...: 1

→ Create Mesh → Surface...

Shell, Element Group - No.1 Surface#: 1

Solution → Data File/Run...

AUI, Post-Processing -> Open: gyak-??.por

Clear (F9) Mesh Plot (F10)

Show Deformed Mesh Show Original Mesh Scale Displacements

List → Value List

DISPLACEMENT: 1 Dispacement DISPLACEMENT_MAGNITUDE

Display → Boundary Conditions → Default megfogások megjeleńıtése

→ Load Plot → Use Default terhelések megjeleńıtése

→ Band Plot → Create...

Eigenvector, EIGENVECTOR_MAGNITUDE

→ Animate



92 13. RÉSZ: Sajátfrekvenciák meghatározása

DATABASE NEW SAVE=NO PROMPT=NO
FEPROGRAM ADINA
CONTROL FILEVERSION=V85
*
FEPROGRAM PROGRAM=ADINA
*
HEADING STRING=’Gyak13 - Sajatertekek, sajatfrekvenciak’
*
MASTER ANALYSIS=FREQUENCIES MODEX=EXECUTE TSTART=0.00000000000000,

IDOF=0 OVALIZAT=NONE FLUIDPOT=AUTOMATIC CYCLICPA=1 IPOSIT=STOP,
REACTION=YES INITIALS=NO FSINTERA=NO IRINT=DEFAULT CMASS=NO,
SHELLNDO=AUTOMATIC AUTOMATI=OFF SOLVER=SPARSE,
CONTACT-=CONSTRAINT-FUNCTION TRELEASE=0.00000000000000,
RESTART-=NO FRACTURE=NO LOAD-CAS=NO LOAD-PEN=NO MAXSOLME=0,
MTOTM=2 RECL=3000 SINGULAR=YES STIFFNES=0.000100000000000000,
MAP-OUTP=NONE MAP-FORM=NO NODAL-DE=’’ POROUS-C=NO ADAPTIVE=0,
ZOOM-LAB=1 AXIS-CYC=0 PERIODIC=NO VECTOR-S=GEOMETRY EPSI-FIR=NO,
STABILIZ=NO STABFACT=1.00000000000000E-10 RESULTS=PORTHOLE,
FEFCORR=NO BOLTSTEP=1 EXTEND-S=YES CONVERT-=NO DEGEN=YES,
TMC-MODE=NO ENSIGHT-=NO

*
FREQUENCIES METHOD=LANCZOS-ITERATION NEIGEN=30 NMODE=30 IPRINT=NO,

RIGID-BO=NO RSHIFT=0.00000000000000 CUTOFF=1.00000000000000E+30,
NITEMM=DEFAULT STURM-CH=NO TOLERANC=DEFAULT INTERVAL=NO,
FMIN=0.00000000000000 FMAX=DEFAULT MODALSTR=NO STATIC=NO,
NSHIFT=AUTO NSHIFT-B=50

*
COORDINATES POINT SYSTEM=0
@CLEAR
1 0.00000000000000 0.00000000000000 0.00000000000000 0
2 0.00000000000000 0.00000000000000 300.000000000000 0
3 5.00000000000000 0.00000000000000 50.0000000000000 0
4 10.0000000000000 0.00000000000000 100.000000000000 0
5 50.0000000000000 0.00000000000000 200.000000000000 0
@
*
LINE STRAIGHT NAME=1 P1=1 P2=2
*
LINE POLYLINE NAME=2 TYPE=SPLINE
@CLEAR
3 0.00000000000000 0.00000000000000 0.00000000000000
4 0.00000000000000 0.00000000000000 0.00000000000000
5 0.00000000000000 0.00000000000000 0.00000000000000
@
*
SURFACE REVOLVED NAME=1 MODE=LINE LINE=0 ANGLE=360.000000000000,

ALINE=1 PCOINCID=YES PTOLERAN=1.00000000000000E-05 NDIV=1
@CLEAR
2
@
*
MATERIAL ELASTIC NAME=1 E=115000.000000000 NU=0.300000000000000,

DENSITY=8.90000000000000E-09 ALPHA=0.00000000000000 MDESCRIP=,
’NONE’
*
FIXITY NAME=NO-TRANSLATION
@CLEAR
’X-TRANSLATION’
’Y-TRANSLATION’
’Z-TRANSLATION’
’OVALIZATION’
@
*
FIXBOUNDARY LINES FIXITY=ALL
@CLEAR
3 ’NO-TRANSLATION’
@
*
EGROUP SHELL NAME=1 DISPLACE=DEFAULT MATERIAL=1 RINT=DEFAULT,

SINT=DEFAULT TINT=2 RESULTS=STRESSES STRESSRE=GLOBAL PRINTVEC=0,
NLAYERS=1 INITIALS=NONE FAILURE=0 SECTION=0 CMASS=DEFAULT,
STRAINS=DEFAULT RUPTURE=ADINA TIME-OFF=0.00000000000000,
OPTION=NONE DESCRIPT=’NONE’ THICKNES=0.200000000000000,
INCOMPAT=DEFAULT PRINT=DEFAULT SAVE=DEFAULT,
TBIRTH=0.00000000000000 TDEATH=0.00000000000000 TINT-TYP=GAUSS

*
SUBDIVIDE LINE NAME=2 MODE=DIVISIONS NDIV=20 RATIO=5.00000000000000,

PROGRESS=GEOMETRIC CBIAS=NO
*
SUBDIVIDE LINE NAME=3 MODE=DIVISIONS NDIV=5 RATIO=1.00000000000000,

PROGRESS=GEOMETRIC CBIAS=NO
*
SUBDIVIDE LINE NAME=4 MODE=DIVISIONS NDIV=20 RATIO=1.00000000000000,

PROGRESS=GEOMETRIC CBIAS=NO
*
GSURFACE NODES=8 PATTERN=AUTOMATIC NCOINCID=BOUNDARIES NCEDGE=1234,

NCVERTEX=1234 NCTOLERA=1.00000000000000E-05 SUBSTRUC=0 GROUP=1,
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PREFSHAP=AUTOMATIC MESHING=MAPPED SMOOTHIN=NO DEGENERA=NO,
COLLAPSE=NO MIDNODES=CURVED METHOD=ADVFRONT FLIP=NO

@CLEAR
1
@*

P5

L3B

L4

CC
C

C
C

C

U
1

U
2

U
3 1 2 3

B - - -

U
1

U
2

U
3

C - - -

X
Y

Z

13.2. ábra. A kürt VEM modellje

MODE 1, F 157.4
TIME 0.000

MODE 3, F 283.4
TIME 0.000 MODE 20, F 1165.

TIME 0.000

13.3. ábra. Kürt néhány lengésképe


